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Лабораторная работа №1 Основы планирования 
 

Отличие проекта от  повседневной операционной деятельности состоит в наличии 
у проекта уникальной цели и временных ограничений. Повседневные операции 
выполняются постоянно, имеют повторяющийся характер, в то время как «проекты 
являются временными и уникальными».  

Главная задача проекта – достижение поставленной цели, после чего проект 
завершается после выполнения поставленных конкретных задач.  

Под управлением проектом  понимается деятельность, направленная на 
эффективное достижение целей проекта в установленные строки, в рамках утвержденного 
бюджета, с заданным качеством. 
В управление проектом входит: 

 Определение требований 
 Установка четких и достижимых целей 
 Уравновешивание противоречащих требований по качеству, содержанию 

времени и стоимости 
Коррекция характеристик, планов и подхода в соответствии с мнением и ожиданиями 
различных участников проекта. 
Основы планирование проекта в MS Project  
Процесс планирования в среде MS Project имеет свою специфику. После того как 
определены цели проекта, сформулированы основные этапы, определено содержание 
основных  этапов, создается план проекта; далее необходимо ввести и структурировать 
список задач проекта,  для каждой задачи ввести длительность, установить зависимости 
между задачами; затем, создать список ресурсов: сотрудников, оборудования и 
материалов, назначить ресурсы на задачи. На основе введенной информации MS Project 
создает расписание. Созданное таким образом расписание можно настраивать и 
оптимизировать. 
Интерфейс программы 
Основные элементы интерфейса программы MS Project представлены на рисунке. Для 
создания нового плана проекта необходимо в меню File (Файл) выбрать команду New 
(Новый) 

 
 

строка меню 

строка меню 

панели 
инструментов 

окно плана проекта 
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В MS Project имеется несколько режимов отображения проектной информации – 
представлений (view), они отображают проектную информацию в различных аспектах. 
По умолчанию, при запуске MS Project план проекта отображается в представлении Gantt 
Chart (Диаграмма Ганта).  Перейти из одного представления в другое можно используя 
меню View (Вид) или специальную панель View Bar (Панель представлений), где 
перечислены все возможные представления. 

В основе планирования лежит время. Существует два  способа планирования 
проекта: от даты начала или от даты окончания. При создании нового проекта необходимо 
зафиксировать способ планирования и указать ключевую дату (дату начала проекта либо 
дату окончания проекта). На основе введенной информации, используя связи, 
установленные между задачами и длительности задач,  MS Project вычисляет вторую из 
дат. 

В меню Project (Проект) необходимо выбрать команду Project Information 
(Информация о проекте). Появляется диалоговое окно для ввода ключевой информации 
о проекте: даты начала или даты окончания.  В раскрывающемся списке Schedule from 
(Планирование с) нужно выбрать способ планирования: от даты начала (Project Start 
Date) или от даты окончания (Project Finish Date). После установления способа 
планирования только одно из полей будет доступно – то, которое соответствует 
выбранному способу планирования, в нем необходимо установить нужную дату. 
 

 
 
Определение календаря рабочего времени  
 

Календарь в MS Project определяет рабочие и нерабочие дни, а также рабочее 
время в рабочие дни. Для проекта назначается основной (базовый) календарь, который и 
будет использоваться при планировании задач в пределах проекта. 
В MS Project предопределено три типа календарей: 

 Standard  (Стандартный) – Пять рабочих дней в неделю (40 рабочих часов в 
неделю), рабочее время с 8.00 до 17.00, перерыв с 12.00 до 13.00 

 24 Hours (24 часа) – Круглосуточное рабочее время – с 0.00 до 24.00, без 
перерывов 
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 Night Shift (Ночная смена) – рабочие дни: с вечера понедельника по утро 
субботы, рабочее время: с 23.00 до 8.00 следующего дня, с часовым перерывом. 

По умолчанию для проекта в качестве основного календаря задается 
Стандартный. Можно выбрать другой календарь, создать новый календарь или 
отредактировать уже имеющийся:  задать в нем праздничные и укороченные дни, 
изменить рабочее время и т.д. 
 Для работы с календарем: 
Tools  Change Working Time  (Сервис  Изменить рабочее время) 
Появляется диалоговое окно Change Working Time ( Изменение рабочего времени) 

 
 
В поле For Calendar (Для календаря) можно выбрать один из трех календарей, 
включенный в MS Project, затем на вкладке Exceptions (Исключения) заполнить поля для 
нерабочих периодов: в поле Name (Название) ввести название периода: например, 
«Новогодние каникулы». В поле  Start (Начало) – указать начальную дату, в поле Finish 
(Окончание) – дату окончания, затем щелкнуть по кнопке ОК диалогового окна. После 
этого указанные дни добавляются к нерабочим дням проекта. 
Выполните лабораторные задания. 
Задание 1. Составьте список задач для проекта «Организация и проведение конкурса на 
лучший студенческий инновационный проект», выделите фазы, обозначьте вехи. 
Задание 2. Откройте MS Project. Создайте новый файл. Найдите панель View Bar 
(Панель представлений). Вызовите диалоговое окно Project Information (Информация 
о проекте). Задайте способ планирования (от даты начала или от даты окончания), 
укажите ключевую дату (дату начала проекта или дату окончания проекта, 
соответственно). Сохраните файл. 
Задание 3. Вызовите диалоговое окно Change Working Time (Изменение рабочего 
времени). Выберите календарь Standard  (Стандартный), затем 24 Hours (24 часа), 
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Night Shift (Ночная смена). Изучите их параметры. Для каких проектов могут быть 
применены данные календари?  
Задание 4.  Вызовите диалоговое окно Change Working Time ( Изменение рабочего 
времени). Выберите календарь Standard  (Стандартный). Задайте 3 нерабочих периода, 
дайте им названия и укажите необходимые даты.  
Задание 5. Откройте MS Project, создайте новый файл. Для учебного проекта 
«Проведение конференции» задайте способ планирования (от даты начала или от даты 
окончания), укажите ключевую дату, выберите календарь, задайте 2 нерабочих периода. 
Сохраните файл. 
 
Лабораторная работа №2 Планирование проекта в MS Project 
Процесс планирования представляет собой составление списка задач. 

Проект всегда имеет определенную цель,  для достижения этой цели необходимо 
выполнить ряд промежуточных задач, получить ряд промежуточных результатов. При 
составлении плана проекта очень важно правильно определить задачи, необходимые для 
достижения поставленной цели. Корректный список задач должен учитывать все работы, 
которые требуются для успешного завершения проекта. 
Для эффективного управления проектом список работ должен быть  структурирован. 
Методы структуризации проекта принципиально сводятся к двум основным типам: 
 метод «сверху-вниз» - сначала  определяются общие задачи, которые затем 

детализируются. Этот метод реализует принцип планирования от общего к частному.  
 метод «снизу-вверх» - сначала определяются частные задачи, которые затем 

обобщаются. Этот метод реализует принцип планирования от частного к общему. 
При любом подходе формируется иерархический список задач. Как только список 

задач сформирован, названия задач можно вводить в план проекта. Для этого, находясь в 
представлении Gantt Chart (диаграмма Ганта), нужно выделить  ячейку в поле Task 
Name (Название задачи) и ввести необходимую информацию (название задачи).  
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Новой введенной задаче по умолчанию присваивается длительность «1 день?». 
Знак вопроса в поле Duration (Длительность) означает, что данное значение параметра 
длительность является приблизительным, оценочным. После редактирования значения 
длительности вопросительный знак исчезнет, но его можно добавить, чтобы пометить 
данное значение  как приблизительное.  
 

 
В правой части представления Gantt Chart (диаграмма Ганта) появляется отрезок 

длиной в 1 день, отображающий введенную задачу. По  умолчанию, для проектов, 
планируемых от даты начала, датой начала новой задачи является дата начала проекта. 
(Для проектов, планируемых от окончания: датой окончания задачи по умолчанию, 
является дата окончания проекта.)  
Названия остальных задач вносятся аналогичным образом. 
 

 
  

В данный момент все задачи (задача № 1, задача № 2, задача № 3, задача № 4, 
задача № 5) являются задачами одного уровня иерархии. Чтобы сделать задачу № 1 
суммарной, необходимо указать, какие задачи она объединяет, и изменить уровень этих 
задач. Для этого необходимо выделить задачи, входящие в задачу № 1 и, щелкнув по 
кнопке Indent Tasks (На уровень ниже), изменить их уровень. 
 
 
 
 
 
 
 
 
 
  
 
 
 
 

кнопка Indent 

Задача № 1 преобразовалась в суммарную задачу, ее отображение на диаграмме Ганта 
изменилось. Задача №2 и задача №3 теперь являются подзадачами задачи №1. 
 
Каждая задача характеризуется длительностью (duration). Длительность может быть 
представлена в различных единицах измерения.  В таблице приведены единицы 
измерения длительности и принятые сокращения. 
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единицы измерения обозначение сокращение 
минута мин (min) м (m) 
час часов (hr) ч (h) 
день дней (day) д (d) 
неделя нед (wk) н (wk) 
месяц месяц (mon) мес (mo) 

 
Необходимо ввести значение длительности для задач в плане проекта. Длительность 
вводится для всех задач (подзадач), кроме суммарных. Суммарная задача отличается от 
обычных задач – ее длительность автоматически вычисляется из параметров длительности 
ее подзадач. 
  

 
 
Ввод вех. Вехой представляют задачу, результат которой особенно важен. Вехой можно 
обозначить  завершение этапа. В MS Project задача становится вехой, если задать ей 
длительность 0. Задачу с ненулевой длительностью можно преобразовать в веху 
следующим образом: двойным щелчком по названию задачи вызвать диалоговое окно 
Task Information (Информация о задаче), на вкладке  Advanced (Дополнительно) 
щелкнуть флажок  Mark task as a milestone (Пометить задачу как веху) 
 

 
 
После преобразования задачи № 3 в веху, ее отображение на диаграмме Ганта сменилось 
на специальный значок вехи 
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Cуммарная задача проекта – специальная суммарная задача, объединяет все задачи 
проекта. Чтобы ее отобразить, необходимо в меню Tools (Сервис) вызвать диалоговое 
окно  Options (Параметры), на вкладке View (Вид) щелкнуть флажок  Show project 
summary task (Показывать суммарную задачу проекта). Суммарная задача 
отображается на нулевом уровне проекта. 
Задачи проекта взаимосвязаны, чтобы учесть этот факт в плане проекта, необходимо 
установить связи между задачами, указать, как время начала или окончания одной задачи 
влияет на время начала или окончания другой задачи. «Определение взаимосвязей 
операций включает в себя идентификацию и документирование логических взаимосвязей 
между плановыми операциями». ([1] с 130) 
 В паре взаимосвязанных задач: 

 задача, оказывающая влияние на другую задачу, называется предшествующей. 
 задача, зависящая от другой задачи, называется последующей. 

В различных представлениях отношения отображаются разными способами. На 
диаграмме Ганта связь обозначается стрелкой. При этом задача, на которую указывает 
стрелка, является последующей.  
 
 
 
 
 
 
 
 
 
 
 
 

линия связи 

последующая задача 
предшествующая задача 

 
В MS Project существует четыре типа отношения зависимости: 
 

 окончание – начало (Finish-to-Start),  
 начало – окончание (Start -to-Finish),  
 начало – начало (Start -to-Start) ,  
 окончание – окончание (Finish-to- Finish).  
 

В зависимости от типа отношения, MS Project  вычисляет время начала или окончания  
задачи, которая является последующей. 
Создать связь между задачами можно несколькими способами.  
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Например, в представлении на диаграмме Ганта: удерживая левую кнопку мыши, 
перетянуть с отрезок, соответствующий одной задаче, на отрезок, соответствующий 
другой задаче. Образуется связь «Окончание-начало», в которой предшествующей будет 
задача, с которой началось перетаскивание.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Другой способ создания связи: выделить две задачи и щелкнуть кнопку Link Tasks 
(Связать задачи) на панели инструментов Стандартная. 
По умолчанию, создается  связь «Окончание-начало».  Тип связи можно изменить.  
В случае, когда активным является представление Диаграмма Ганта или Сетевой график, 
удобно использовать диалоговое окно Зависимость задач (Task Dependency) для 
изменения типа связи.  

 
 
Диалоговое окно  вызывается двойным щелчком по линии связи. В выпадающем списке 
Тип (Type) выбрать нужный тип зависимости. 
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Если в активном представлении отображается поле «Предшествующие задачи» 
(Predecessors), в нем указаны предшествующие задачи и тип связи, если она отлична от 
«Окончание-начало». Данные в этом поле можно изменять. 
 

 
 
 
Независимо от представления, можно использовать диалоговое окно «Информация о 
задаче» (Task Information). Для отображения диалогового окна необходимо сделать 
двойной щелчок на задаче или, выделив задачу, щелкнуть кнопку «Информация о 
задаче» (Task Information) на панели Стандартная. В диалоговом окне необходимо 
перейти на вкладку «Предшествующие задачи» (Predecessors). Таблица, представленная 
на этой вкладке, содержит информацию о задаче, которая предшествует данной и о типе 
связи, установленной между ними. В поле Название задачи (Task Name) из 
раскрывающегося списка можно выбрать предшествующую задачу, а в раскрывающемся 
списке Type (Тип) - тип связи. 
 

 
 
Подробно о каждом из типов отношений. 
 
Окончание – начало (ОН)  или Finish-to-Start (FS) – наиболее распространенный вид 
связи. Пусть существуют задача А и задача Б, задана связь «окончание-начало», при 
которой  задача А – предшествующая, задача Б – последующая. Такая связь означает, что 
задача Б не может начаться, пока не закончена задача А. Пример такой связи: задача 
«Написание объявления» (предшествующая) и задача «Вывешивание объявления на доске 
объявлений» (последующая). Пока объявление не написано, его нельзя поместить на доске 
объявлений. 
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При увеличении длительности предшествующей задачи, время ее окончания 
пересчитывается и сдвигается на более поздний срок, начало последующей задачи зависит 
от времени окончания предыдущей задачи и также сдвигается. 
 

 
 
  
Начало – начало (НН)  или Start – to  - Start (SS). Такой вид связи устанавливается для 
пары работ, которые должны выполняться почти одновременно. В этом случае не 
требуется завершения предшествующей задачи для начала последующей задачи, но 
последующая задача должна начаться не раньше начала предшествующей. Если для  задач 
А и Б задана связь «начало-начало», при которой  задача А – предшествующая, задача Б – 
последующая, это означает, что задача Б не может начаться, пока не началась задача А, 
т.е. дата начала предшествующей задачи определяет дату начала последующей задачи.  
 

 
 
 
При увеличении длительности предшествующей задачи, время ее окончания 
пересчитывается, но так как начало последующей задачи зависит только от времени 
начала предыдущей, то изменение длительности предшествующей задачи не влияет на 
время начала и окончания последующей задачи.  
 

 
 
 
Окончание – окончание (ОО)  или Finish-to-Finish (FF). Окончание последующей 
задачи контролируется окончанием предшествующей задачи. Последующая задача не 
может закончиться раньше, чем заканчивается предшествующая задача. Пусть 
существуют задачи А и  Б, задана связь «окончание – окончание», при которой  задача А – 
предшествующая, задача Б – последующая. Обозначает, что задача Б не может 
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закончиться, пока не закончилась задача А, т.е. дата окончания предшествующей задачи 
определяет дату окончания последующей задачи.  
 

 
 
При увеличении длительности предшествующей задачи, время ее окончания 
пересчитывается, и, так как время окончания последующей задачи зависит от времени 
окончания предыдущей (задача Б не может закончиться, пока не закончилась задача А), то 
изменение длительности предшествующей задачи привело к перемещению даты начала 
последующей задачи на более поздний срок.  

 
 
Начало–окончание (НО)  или Start-to-Finish (SF). Окончание последующей задачи 
возможно только после начала предыдущей задачи. Пусть для задач А и Б задана связь 
«начало-окончание», при которой  задача А – предшествующая, задача Б – последующая. 
Обозначает, что задача Б не может закончиться, пока не началась задача А. 
 

 
 
При увеличении длительности предшествующей задачи, время ее окончания 
пересчитывается, а время начала не изменяется, следовательно, не влияет на 
последующую задачу. В случае изменения длительности последующей задачи, ее начало 
сдвигается на более раннее время, т.к. окончание последующей задачи не может быть 
передвинуто на более позднее время – оно контролируется началом предшествующей 
задачи. 
 
 

 
 
  
MS Project предоставляет возможность при указании типа связи между задачами ввести 
параметры Запаздывание (Lag) или Опережение (Lead). «Опережение позволяет 
ускорить последующую операцию. Например, команда технических специалистов может 
приступить к написанию второго проекта крупного документа (последующей операции) 
за 15 дней до того, как они полностью закончат первый проект (предшествующую 
операцию). Это может быть достигнуто при помощи взаимосвязи «финиш-старт» с 15-
дневным опережением. 
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Задержка управляет приостановкой последующей операции. К примеру, чтобы 
обеспечить десятидневный срок затвердевания бетона, можно использовать 
десятидневную задержку  во взаимосвязи «финиш-старт», что означает 
невозможность начала последующей операции до того, как завершится 
предыдущая».([1] с. 134) 
Значения данных параметров вводятся в поле Запаздывание (Lag), но значение 
параметра Опережение необходимо вводить как отрицательную величину. Значение 
любого из этих параметров может быть представлено в единицах времени или в 
процентах от длительности предшествующей задачи. Например, если в поле 
Запаздывание (Lag) для задачи введено значение « - 1 d » при связи «Окончание - 
начало», это означает, что данная задача начинается за 1 день до времени окончания 
предшествующей задачи. В приведенном примере в представлении Диаграмма Ганта 
показаны: опережение в 1 день для задачи Б, запаздывание на 25% для задачи В. 
 

    
 
 
При планировании проекта часто возникает необходимость привязки начала или 
окончания задачи (этапа) к некоторой фиксированной дате. В этом случае нужно учесть в 
плане проекта, что «задача должна закончиться не позднее» конкретной даты или «задача 
должна начаться» в конкретное время и т.д. Для учета и обработки требований, связанных 
с фиксированием дат, сроков, в MS Project предусмотрена  обработка ограничений.   
Существует восемь возможных типов ограничений. Ограничения могут быть гибкими и 
негибкими (или жесткими). 
 
 

тип ограничения описание 
гибкие ограничения 

Как Можно Раньше (КМР) 
As Soon As Possible (ASAP) 

Задача должна начаться как можно раньше, 
с учетом других параметров плана. 
Этот тип ограничения по умолчанию 
накладывается на все задачи, если проект 
планируется от даты начала 

Как Можно Позже (КМП) 
As Late As Possible (ALAP) 

Задача должна начаться можно позже с 
учетом других параметров плана. 
Этот тип ограничения по умолчанию 
накладывается на все задачи, если проект 
планируется от даты окончания 

полужесткие ограничения 
Начало Не Ранее (ННР) Это ограничение обозначает наиболее 

позднюю дату, когда задача может 
начаться. Задача может начинаться раньше 
или в этот день, но не позже.  

Start No Earlier Than (SNET) 

Для проектов, планирующихся от даты 
окончания, это ограничение применяется, 
при  вводе даты начала задачи 
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Окончание Не Ранее (ОНР) 
Finish No Earlier Than (FNET) 

Это ограничение обозначает наиболее 
раннюю дату, когда задача может 
закончиться. Задача может закончиться в 
этот день или позже, но не раньше. 
Для проектов, планирующихся от даты 
начала, это ограничение применяется, при 
вводе даты окончания задачи  

Начало Не Позднее (ННП) 
Start No Later Than (SNLT) 

Это ограничение обозначает наиболее 
позднюю дату, когда задача может 
начаться. Задача может начаться в этот день 
или раньше, но не позже. 
Для проектов, планирующихся от даты 
окончания, это ограничение применяется, 
при  вводе даты начала задачи  

Окончание Не Позднее (ОНП) 
Finish No Later Than (FNLT) 

Это ограничение обозначает наиболее 
позднюю дату, когда задача может 
закончиться. Задача может закончиться в 
этот день или раньше, но не позже. 
Для проектов, планирующихся от даты 
окончания, это ограничение применяется, 
при  вводе даты окончания задачи  

негибкие (жесткие) ограничения 
Фиксированное Начало(ФН) 
Must Start On (MSO) 

Это ограничение обозначает точную дату, 
когда должно начаться выполнение задачи.  

Фиксированное Окончание (ФО) 
Must Finish On (MFO) 

Это ограничение обозначает точную дату, 
когда выполнение задачи должно 
завершиться.  

 
Ввод ограничений  
В проектах, планируемых от даты начала, по умолчанию все задачи имеют ограничение 
КМР (ASAP). В проектах, планируемых от даты окончания, по умолчанию все задачи 
имеют ограничение КМП (ALAP). 
Изменять ограничения, предлагаемые по умолчанию, можно, например, вводя дату начала 
или окончания задачи в представлении Диаграмма Ганта. Сразу после этого в поле 
«Индикаторы» (Indicators) отображается специальный значок, указывающий на наличие 
у задачи ограничения. При подведении указателя мышки к такому значку, появляется 
пояснение «Эта задача имеет ограничение Окончить Не Позднее» 
 

 
 
Ограничение может быть установлено с помощью диалогового окна «Информация о 
задаче» (Task Information). Для отображения диалогового окна необходимо сделать 
двойной щелчок на названии задачи или, выделив задачу, щелкнуть кнопку 
«Информация о задаче» (Task Information) на панели Стандартная. В диалоговом окне 
необходимо перейти на вкладку «Дополнительно» (Advanced), в раскрывающемся 
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списке «Тип ограничения» (Constraint type) выбрать нужный тип ограничения, в списке 
Дата ограничения (Constraint date) – указать дату.  
Для отмены ограничения необходимо указать для задачи одно из гибких ограничений - 
КМР (ASAP) или КМР (ALAP), в зависимости от способа планирования.  
 

 
 
 
В представлении Диаграмма Ганта можно создавать или изменять ограничения с 
помощью таблицы Даты Ограничений (Constraint Dates)  
 

 
 
При введении жесткого ограничения может возникнуть ситуация, когда установленные 
для задачи связи вступают в конфликт с датой ограничения. По умолчанию, MS Project 
отдает больший приоритет ограничениям, игнорируя свойства связей. При возникновении 
конфликтной ситуации отображается предупреждение. 
Введение жестких типов ограничений существенно уменьшает гибкость планирования. 
Существует альтернативный способ учета фиксированной даты – установление крайнего 
срока (deadline). Крайний срок определяет предельную  дату исполнения задачи, но не 
накладывает никаких ограничений и не влияет на расчеты (если только не принят способ 
планирования от окончания  и связи КМП).  
Для установки крайнего срока необходимо вызвать диалоговое  окно «Информация о 
задаче» (Task Information) – сделать двойной щелчок на названии задачи или, выделив 
задачу, щелкнуть кнопку «Информация о задаче» (Task Information) на панели 
Стандартная. В диалоговом окне, на вкладке «Дополнительно» (Advanced), внести (или 
выбрать в календаре) нужную дату. 
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На Диаграмме Ганта крайний срок отображается специальным значком. 

поле Крайний срок (Deadline) 

 
 
 
 
 
 
 
 
 
 
 
 

Крайний срок 

 
Если при изменении каких-либо параметров в плане проекта выполнение задачи не может 
быть завершено в указанный срок, в поле Индикаторы (Indicators) появляется красный 
значок, при наведении на него указателя мышки отображается всплывающая подсказка с 
информацией о выходе за крайний срок. 

 
В случае использования крайнего срока принципы размещения задач не изменяются, это 
позволяет использовать MS Project как аналитический инструмент при планировании.   
Повторяющиеся задачи 
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Многие проекты содержат события, которые повторяются с заданной регулярностью. 
Например, «заседание Оргкомитета», «подготовка еженедельного отчета» и т.д. Подобные 
события могут быть  включены в план проекта как обычные задачи, но можно их ввести 
как повторяющиеся задачи, с заданной периодичностью. В этом случае MS Project 
создает последовательность задач, не связанных никакими отношениями. 
Для создания повторяющейся задачи необходимо в представлении Диаграмма Ганта 
выделить ячейку в поле Task Name, затем в меню  Insert (Вставка) щелкнуть команду 
Recurring Task (Повторяющаяся задача). Появится диалоговое окно Recurring Task 
Information (Информация о повторяющейся задаче). В поле Task Name (Название 
задачи) нужно ввести название, например, «заседание Оргкомитета»; в поле Duration 
(Длительность) – длительность задачи. В группе Recurrence pattern (Повторять)  
необходимо установить периодичность:  Daily (Ежедневно), Weekly (Еженедельно), 
Monthly (Ежемесячно) или Yearly (Ежегодно). В зависимости от выбранной 
периодичности, справа от переключателей появится группа параметров, уточняющих 
выбранную частоту.  В группе Range of recurrence (Пределы повторения) необходимо 
указать дату для первого вхождения повторяющейся задачи – поле Start  (Начало), а 
также установить количество повторений - либо выбрать число повторений (команда End 
After и ввести количество повторений), либо указать дату окончания этой задачи (команда 
End by и ввести дату) 
 

 
Задача добавляется в план проекта со специальным значком в поле Indicators 
(Индикаторы) 
 
 

 

 

 

 
значок повторяющейся задачи 

 
Список ключевых терминов.суммарная задача проекта, предшествующая задача, 
последующая задача, тип отношения зависимости, опережение, запаздывание, 
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ограничение, гибкое ограничение, негибкое ограничение, крайний срок,  повторяющиеся 
задачи 

Выполните лабораторные задания. 
Задание 1. Создайте новый файл в MS Project. Проверьте, что включено представление 
Gantt Chart (диаграмма Ганта), В поле Task Name (Название задачи) введите названия 
10 задач учебного проекта (например, «задача1», «задача2» и т.д.). Задачи под номерами 
1, 5, 7 преобразуйте в суммарные. Создайте вехи. Измените длительность задач (где это 
возможно) и проследите  за изменением отображения на диаграмме Ганта. Отобразите 
суммарную задачу проекта. 
Задание 2. Создайте связи между задачами. Связь какого типа будет создана по 
умолчанию? Попробуйте менять тип связи и удалять связи. Проследите за отображением 
изменений.  
Задание 3. Добавьте в проект любое жесткое ограничение для задачи, у которой есть 
предществующая. Измените длительность предшествующей задачи, так чтобы 
установленное ограничение было нарушено. Измените тип ограничения. Удалите 
ограничение. 
Задание 4. Введите крайний срок для задачи, имеющей предшествующую задачу. 
Измените длительность предшествующей задачи, так чтобы установленный крайний срок 
был нарушен. Удалите крайний срок. 
Задание 5. Составьте список задач для вашего собственного учебного проекта (например, 
«Празднование юбилея близкого родственника»). Создайте новый файл в MS Project. 
Введите названия задач вашего проекта. 

 
Лабораторная работа №3 Планирование ресурсов и создание назначений 

 
Эффективное управление ресурсами – одно из главных достоинств MS Project. 

Планирование ресурсов начинается с определения состава ресурсов. Ресурсы – это 
исполнители, оборудование и материалы, необходимые для выполнения задач проекта.  
В MS Project для ресурсов определены свойства: доступность и стоимость. Доступность 
определяет, когда ресурс может работать над выполнением задач проекта, стоимость – 
затраты, связанные с использованием данного ресурса в проекте. 
  

 Для работы со списком ресурсов предназначено представление Resource Sheet 
(Лист ресурсов). Чтобы переключиться в это представление, можно в меню View (Вид) 
выбрать Resource Sheet (Лист ресурсов). Ввод ресурсов удобно производить, используя 
таблицу Entry (Ввод).  

 
В поле Resource Name (Название ресурса) вводится название ресурса. Значение 

поля Type (Тип) необходимо выбрать из раскрывающегося списка. В MS Project 
представлено три типа ресурсов – Work (Трудовой), Material (Материальный), Cost 
(Затратный).  
Трудовые ресурсы – это исполнители и оборудование, занятые в проекте.   
Материальные ресурсы – материалы, потребляемые при выполнении задач проекта. 
Затратные ресурсы – затраты, которые  не связаны с использованием трудовых или 
материальных ресурсов, но должны быть учтены в плане проекта. 
Тип ресурса определяет принцип учета данного ресурса в плане проекта. Участие в 
проекте трудовых ресурсов исчисляется во временных единицах,  материальных ресурсов 
– в количественных, поэтому после выбора типа ресурса многие поля таблицы 
заполняются значениями, принятыми по умолчанию.. 
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Поле Material Label (Единицы измерения материалов) доступно только для 
материальных ресурсов, оно содержит единицы измерения данного ресурса. 
Поле Max. Units (Макс. единиц) определяет максимальную доступность ресурса для 
проекта. Значение 100% в этом поле означает, что данный ресурс будет занят на проекте 
все свое рабочее время.  

В списке ресурсов трудовой ресурс может быть представлен не только конкретным 
человеком, но и  названием профессии или специальности: например, «программист» или 
«редактор» - когда неважно, кто персонально будет назначен на данную задачу. Для 
такого ресурса поле Max. Units (Макс. единиц) может иметь значение, превышающее 
100%, т.к. в качестве данного ресурса может быть задействовано сразу несколько 
исполнителей. Поле Max. Units (Макс. единиц) недоступно для материальных ресурсов, 
т.к. они являются потребляемыми. 
 
Определение рабочего времени ресурсов. 
 
 

По умолчанию, все сотрудники, добавленные в проект, считаются доступными для 
работы над проектом все свое рабочее время. Для каждого ресурса создается календарь, 
параметры которого совпадают с параметрами основного (базового) календаря проекта.  
Однако некоторые ресурсы могут иметь свой персональный график работы, кроме того, 
необходимо учесть периоды отпусков или неполную занятость ресурса на задачах данного 
проекта. «Календари ресурсов затрагивают определенный ресурс или категорию 
ресурсов. Из календаря ресурсов видно, что некоторые ресурсы работают только 
стандартное рабочее время, тогда как другие работают три полные смены, или что 
член команды проекта может быть недоступен из-за отпуска или участия в семинаре, 
или, к примеру, что некоторые  сотрудники работают лишь по определенным дням 
недели согласно условиям контракта» ([1] с 148) 

 
 
Если сотрудник может работать над задачами проекта только половину рабочего 

дня, то его  доступность в поле Max. Units (Макс. единиц) устанавливается 50%. 
В диалоговом окне Resource Information (Информация о ресурсе) можно установить 
периоды доступности ресурса. Диалоговое окно вызывается двойным щелчком по ячейке 
с названием ресурса  в представлении Resource Sheet (Лист ресурсов) или, выделив 
название нужного ресурса, щелкнуть по кнопке Resource Information (Информация о 
ресурсе) панели инструментов  Standard (Стандартная).  
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На вкладке General (Общая) отображается таблица Resource Availability (Доступность 
ресурса). В поле Available From (Доступен с) необходимо указать дату начала периода 
доступности, т.е. дату ввода ресурса в проект, в поле Available To (Доступен до) – дату 
окончания периода доступности, в поле Max. Units (Макс. единиц) – значение  
доступности. По умолчанию, значением двух первых полей является NA (НД) 

 
 
Для определения рабочего времени и выходных дней ресурса, может быть создан 
собственный календарь ресурса. Для работы с календарем необходимо из диалогового 
окна Resource Information (Информация о ресурсе), перейдя на вкладку Working Time 
(Рабочее время). Другой способ: в меню Tools (Сервис) выбрать команду Change 
Working Time (Изменить рабочее время), в появившемся диалоговом окне в 
раскрывающемся списке For (Для) выбрать название нужного ресурса. В календаре 
ресурса необходимо зафиксировать особенности рабочего графика ресурса. 
 
Назначения. 
Назначение – это выделение задаче ресурсов, необходимых для ее выполнения. 
Назначить ресурсы на задачи – это значит определить, какие задачи выполняют данные 
ресурсы, или какие ресурсы выделены для выполнения данных задач.  
Для назначения ресурсов необходимо в представлении Gantt Chart (Диаграмма Ганта) 
щелкнуть по кнопке Assign Resources (Назначить ресурсы) на панели инструментов 
Standard (Стандартная). Появится диалоговое окно Assign Resources (Назначить 
ресурсы), в котором отображаются все созданные для проекта ресурсы. Далее, выделив 
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название  задачи, необходимо выбрать в представленном списке ресурсов нужное 
название и щелкнуть по кнопке Assign (Назначить) диалогового окна. Все назначенные 
ресурсы помечаются в списке галочкой.  
Для удаления назначения необходимо выделить задачу, на которую назначен ресурс, в 
диалоговом окне Assign Resources (Назначить ресурсы) выделить ресурс и щелкнуть по 
кнопке Remove (Удалить) диалогового окна. 
Ресурсы на задачу  могут быть назначены и из диалогового окна Task Information 
(Информация о задаче). На вкладке  Resources (Ресурсы) отображается таблица, 
состоящая из трех столбцов: Resource Name (Название ресурса), Units (Единицы), Cost 
(Затраты). Для трудовых ресурсов единицы измерения  - проценты или десятичные числа 
(при этом 100% соответствует 1 и означает полную занятость исполнителя на данной 
задаче).  
При назначении материальных ресурсов в поле Units (Единицы) вводится значение, 
обозначающее количество (объем) данного ресурса   в единицах, указанных в поле 
Material Label (Единицы измерения материалов). Объем выделяемых ресурсов (или 
норма потребления ресурсов) может быть фиксированным или переменным.  При 
фиксированном объеме (норме потребления) на решение задачи выделяется указанное 
количество ресурсов, и оно не зависит от длительности задачи.  Формат ввода: число, 
например, число « 5 » в поле Units (Единицы) будет означать фиксированную норму 
потребления для данного ресурса – 5 единиц данного ресурса на все время выполнения 
задачи. Переменный объем (норма потребления) зависит от длительности задачи. При 
изменении длительности задачи объем потребленного ресурса пересчитывается 
автоматически.  Формат ввода: число/единица измерения времени, например, « 5/day» 
соответствует переменной норме, 5 единиц ресурса в каждый день на протяжении 
времени выполнения задачи. 
 
Пока задаче не присвоены ресурсы, она имеет длительность, но не имеет объема работ - 
объем работ определяется трудозатратами тех ресурсов, которые назначены на 
выполнение задачи. Трудозатраты зависят от длительности задачи и объема ресурсов, 
выделенных для исполнения задачи. Размещение задачи в плане и ее поведение при 
изменении параметров (длительности, объема работ и трудозатрат) зависят от типа 
задачи. 
Тип задачи – характеристика задачи, зависит от того, какие из параметров задачи  
зафиксированы, а какие могут изменяются. Любой из трех параметров задачи может быть 
зафиксирован, вынуждая изменяться два других параметра. Тип задачи указывает, какой 
из параметров задачи фиксирован: трудозатраты, объем ресурсов или длительность, и как 
изменение одного из свободных параметров задачи   влияет на значение другого. В MS 
Project существует три типа задач: 
 

 Fixed Units (Фиксированный объем ресурсов),  
 Fixed Work (Фиксированные трудозатраты),  
 Fixed Duration (Фиксированная длительность).  

Тип задачи устанавливается на вкладке Advanced (Дополнительно) диалогового окна 
Task Information (Информация о задаче) 
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Тип Fixed Units  (Фиксированный объем ресурсов) устанавливается для задачи, если 
необходимо, чтобы объем ресурсов задачи не изменялся при изменении длительности или 
трудозатрат, назначенных на выполнение задачи. Т.е. длительность и трудозатраты 
полностью определены объемом ресурсов, выделенными на выполнение задачи. Этот тип 
присваивается задачам по умолчанию. 

 При изменении трудозатрат пересчитывается длительность, но объем 
ресурсов не меняется. 

 При изменении длительности пересчитываются трудозатраты, но объем 
ресурсов не меняется. 

Тип Fixed Duration (Фиксированная длительность) устанавливается, когда необходимо, 
чтобы длительность задачи не изменялась при изменении трудозатрат  или количества 
исполнителей, назначенных на выполнение задачи. Применяется для задач, время 
выполнения которых не может быть изменено назначением (или удалением) сотрудников. 

 При изменении объема ресурсов пересчитываются трудозатраты. 
 При изменении объема работ пересчитывается объем ресурсов    

Тип Fixed Work (Фиксированные трудозатраты) устанавливается, когда необходимо, 
чтобы трудозатраты задачи не изменялись при изменении длительности или объема 
ресурсов, назначенных для выполнения задачи.  Если у задачи такого типа увеличить 
длительность, т.е. выделить ресурсам больше времени, то нагрузка на ресурсы в единицу 
времени уменьшится. Если выделить больше сотрудников, то уменьшится длительность. 
По определению, все задачи типа  Fixed Work  являются задачами с фиксированным 
объемом работ.  

 При изменении объема работ пересчитывается длительность 
 При изменении длительности пересчитывается объем ресурсов  

Фиксированный объем работ.  
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При увеличении или уменьшении количества ресурсов, назначенных на задачу,  MS 
Project уменьшает или увеличивает длительность задачи в зависимости от количества 
ресурсов, назначенных на выполнение задачи, при этом трудозатраты не изменяются. 
Этот способ планирования называется планированием с фиксированным объемом работ, 
этот способ используется в MS Project по умолчанию, как только ресурсы назначены на 
задачи. 
При первом назначении  ресурсов на задачи, трудозатраты вычисляются и фиксируются, 
доля от общего объема трудозатрат, выделенная  каждому из ресурсов, меняется. 
Планирование с фиксированным объемом работ имеет смысл, только когда ресурсы, 
назначенные на задачу, добавляются или удаляются. 
Планирование с фиксированным объемом работ не применимо, когда изменяются 
трудозатраты, длительность, объем ресурсов уже назначенных на задачу. 

Календарь задачи 

Задачи могут иметь свой календарь, не совпадающий с календарем проекта. Календарь 
задачи может быть установлен на вкладке Advanced (Дополнительно) диалогового окна 
Task Information (Информация о задаче). Календарь задачи может не совпадать с 
календарем ресурсов, назначенных на выполнение задачи. По умолчанию, календарь 
ресурса имеет приоритет над календарем задачи, для смены приоритета необходимо на 
вкладке Advanced (Дополнительно) диалогового окна Task Information (Информация о 
задаче) установить флажок Scheduling ignores resource calendars (Не учитывать 
календари ресурсов при планировании). 

Свойства назначений 

Свойства назначений могут быть изменены с помощью диалогового окна Assignment 
Information (Информация о назначении). Диалоговое окно вызывается в представлении 
Task Usage (Использование задач) двойным щелчком на назначении или, выделив 
ресурс,  щелкнуть по кнопке  Assignment Information (Информация о назначении) на 
панели инструментов Standard (Стандартная).  
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Вкладка General (Общая) содержит поля, в которые может  быть внесена информация о 
доступности ресурсов в разные периоды времени. На этой же вкладке можно изменить 
профиль загрузки. Профиль загрузки показывает, как трудозатраты ресурса 
распределены во времени. Раскрывающийся список Work contour (Профиль загрузки) 
содержит  восемь возможных типов профилей загрузки. По умолчанию, устанавливается 
профиль загрузки Flat (Плоский), означающий равномерное распределение нагрузки 
исполнителя. Если специфика задачи требует различных трудозатрат на разных этапах 
выполнения, можно для ресурса выбрать профиль загрузки, соответствующий 
требованиям задачи. Back Loaded (Загрузка в конце) – большая часть нагрузки выпадает 
на последний этапы задачи, Front Loaded (Загрузка в начале) - большая часть нагрузки 
распределена на начальный этапы задачи, Double Peak (Двойной пик) – два пика в 
середине задачи, Early Peak (Ранний пик) – пик загрузки в начале задачи, Late Peak 
(Поздний пик) – пик загрузки в конце задачи,  Bell (Колокол) – пик нагрузки в середине 
периода выполнения задачи, Turtle (Черепаха) –  уровень нагрузки плавно увеличивается 
к  середине периода выполнения задачи, затем плавно уменьшается . 

 

В зависимости от установленного профиля нагрузки в поле Indicators (Индикаторы) 
появляется соответствующий профилю значок и  меняется распределение нагрузки 
ресурса по времени. На примере показано применение профилей  Back Loaded (Загрузка 
в конце), Front Loaded (Загрузка в начале), Turtle (Черепаха). Для отображения 
использовано представление Task Usage (Использование задач). 

 

Вкладка General (Общая) диалогового окна Assignment Information (Информация о 
назначении)  содержит поля Start (Начало) и Finish (Окончание). По умолчанию, 
значения этих полей заполняются датами начала и окончания задачи. Если период работы 
ресурса  над задачей определяется другими датами – значения полей Start (Начало) и 
Finish (Окончание) могут быть отредактированы.  

Выполните лабораторные задания. 
Задание 1.  Откройте файл с учебным проектом. Перейдите в представление Resource 
Sheet (Лист ресурсов), таблица - Entry (Ввод). Введите названия ресурсов:  «Иванов 
И.И», установите для него тип ресурса «трудовой»; «Сорокина С.Т.» -  тип «трудовой»; 
«оператор» - тип «трудовой»; «бумага» - тип «материальный». Подумайте, какие еще 
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ресурсы необходимы для выполнения вашего проекта, внесите их в список, укажите их 
тип. 
 
Задание 2. Вызовите диалоговое окно Resource Information (Информация о ресурсе) 
для ресурса «Иванов И.И.». Установите для него периоды доступности: от даты начала 
проекта, на срок две недели – 50%; затем ресурс недоступен в течение 7 дней, затем 
доступен 100% до окончания проекта.   
 
Задание 3. Назначьте ресурсы «Иванов И.И.», «Сорокина С.Т.» на задачи вашего 
учебного проекта. Используйте для этого разные способы.  
 
Задание 4. Для задачи  учебного проекта установите тип Fixed Duration 
(Фиксированная длительность). Назначьте дополнительные ресурсы на задачу. 
Проследите за изменениями. Это же задание выполните, установив другой тип задачи. 
Сравните результаты.   
 
Задание 5. Перейдите в представление Task Usage (Использование задач), вызовите 
Assignment Information (Информация о назначении) для назначения. Измените 
профиль загрузки ресурса на Front Loaded (Загрузка в начале). Проследите за 
изменением нагрузки ресурса по времени. Для оставшихся  назначений установите другие 
профили загрузки, сравниете распределение загрузки по времени для различных 
профилей.  

 
Лабораторная работа №4 Внесение в план проекта дополнительной 
информации 

Часто, после того, как определен состав задач и ресурсов проекта, сделаны 
назначения, необходимо внести в проект дополнительную информацию, например 
комментарии. Иногда требуется прокомментировать отдельное назначение или ресурс. 
Если задачи структурированы с помощью фаз, то ресурсы в представлении лист ресурсов 
никак не структурированы. Для структурирования их, или задач другим способом, можно 
использовать коды структур. Например, присвоить ресурсам код отдела, к которому они 
относятся, и сгруппировать по этому коду. Можно также определить объем трудозатрат 
определенного отдела, спланировать его загрузку и т.д. 

Дополнительную информацию можно вносить как в стандартные, так и в 
настраиваемые поля.  Стандартные поля: поле кода структуры задач; поле приоритета; 
имена групп ресурсов, заметок и гиперссылок для задач, ресурсов и назначений. 
Нестандартные поля могут относиться и к задачам и к ресурсам и бывают двух типов: 
собственно настраиваемые поля, и настраиваемые поля кодов структур.  

Код структуры задач. 
Коды используются для идентификации задач, учета их исполнения, анализа 

трудозатрат и прочего. Например, собрав данные из однотипных проектов об одном и том 
же отделе можно сравнить производительность разных команд.  
 Определение кодов задач делают в диалоговом окне WBS Code Definition 
(Определение кодов СДР) Здесь аббревиатура WBS означает Work Breakdown Structure – 
Структурная декомпозиция работы. Уже заданные коды структуры задачи можно увидеть 
в файле project1.mpp. Для этого следует добавить в таблицу колонку с полем WBS. Для 
создания нового кода или изменения существующего надо открыть специальное окно в 
меню команд Project > WBS > Define Code (Проект>СДР>Определить код).    

Хотя каждой задаче присваивается уникальный код, он может начинаться с общего 
префикса кода проекта. Префикс будет одинаковым для всех задач проекта и вводится в 
специальную строку Project Code Prefix(Префикс кода проекта). Чтобы отметить все 
уровни структуры задачи, ее уникальный код строится из нескольких 
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последовательностей символов, отделенных друг от друга разделителями. В каждом из 
уровней можно использовать свой тип символов. Для определения нового уровня надо 
просто использовать следующую строку в таблице. Точно также легко удалить уровень 
простым удалением строки. В таблице нетрудно видеть, каким образом ее можно 
заполнить для определения кодов, а также в последней графе представлены все 
возможные типы символов. Длина последовательности задается во втором поле таблицы. 
Этот параметр определяет, сколько элементов можно будет перенумеровать с помощью 
этого кода.  Если при добавлении параметра вам будет не хватать выбранной длины, 
программа выдаст предупреждение. Если длину выбрать больше единицы, то при 
генерации кодов для задачи в них будут включаться нули перед первой значимой цифрой. 
Для текстовых последовательностей первой будет буква А. Если вы не хотите видеть 
лишние нули, надо указать длину «any»(любая). В последней колонке можно выбрать 
сепаратор, который будет отделять символьные последовательности, то есть разделять 
коды разных уровней. Образец кода отображается в окне просмотра.  

 

  
 
 Если установить флажок Generate WBS cod for new task (Создавать коды СДР для 
новых задач), то каждой новой задаче автоматически будет присваиваться код. Установка 
флажка Verify uniqueness of new WBS codes (Проверять уникальность новых кодов 
СДР) обеспечит проверку уникальности  кодов, введенных вручную. 
 Присвоить новые коды можно с помощью команды Project > WBS > 
Renumber(Проект>СДР>Изменить нумерацию). Для того чтобы можно было увидеть 
коды задач, как уже упоминалось, необходимо добавить в таблицу колонку с полем WBS. 
При изменении кода более высокого уровня, автоматически изменяются все вложенные 
коды. Таким способом можно назначить собственные коды блокам задач. Например, 
переопределить код в файле, задав третий уровень как «characters» с длиной «any». А 
потом переименовать у задачи «start.text» код (в свойствах задачи вкладка Advanced), 
задав другое значение для первого кода последовательности, не число, а например, слово 
«new». Вы увидите, как изменятся все вложенные коды задачи.  
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Приоритет задач и группы ресурсов. 
Приоритет отражает важность исполнения задачи для проекта. Эта числовая величина, 
меняющаяся от 1 до 1000. По умолчанию, установленный в диалоговом окне сведений о 
проекте, приоритет равен 500.  Изменить  его можно на вкладке General(Общие) 
диалогового окна сведений о задаче. Если исполнение некоторых задач можно отложить, 
то им присваивается низкий приоритет.  
 
   Информация о группе ресурса вводится в поле Group(Группа) вкладки 
General(Общие) диалогового окна сведений о ресурсе или таблицы Entry(Ввод) 
представления Resource Sheet(Лист ресурсов). Эта информация может потребоваться при 
определении перегрузки ресурса, или для сортировки.  
 
 

 
 
 
Заметки и документы. 
 Чтобы  сопроводить какую-либо задачу или ресурс заметкой или документом 
нужно использовать вкладку Notes(Заметки) диалогового окна сведений о задаче или 
ресурсе.  
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Рассмотрим добавление заметок и документов на примере какой-либо  задачи, 
открыв файл project.mpp и дважды щелкнув по любой задаче.  Затем следует выбрать 
вкладку Notes(Заметки). На открывшейся вкладке будет расположено многостраничное 
поле редактора заметок с очевидными функциями. Особого упоминания заслуживает 
функция добавления объекта из файла, к ней мы еще вернемся. А сейчас посмотрим, как 
выглядят задачи содержащие заметки. В поле индикаторов они имеют соответствующий 
значок. При наведении на него курсора отображается текст заметки. Однако если вставлен 
объект из файла, то информация о нем не отображается при наведении курсора. В 
дальнейшем для отбора задач с заметками можно воспользоваться фильтром Tasks with 
attachment(Задачи с заметками). Для редактирования заметок можно добавить 
соответствующий столбец в таблицу, или использовать поле Notes(Заметки). Чтобы 
связанный с задачей файл был виден его можно вставить прямо в диаграмму Ганта, 
используя команду  Insert > Object(Вставка>Объект). В открывшемся окне есть два 
переключателя, они позволяют выбрать, каким образом будет вставлен объект. Если 
выбран пункт «создать новый объект», то откроется специальное приложение для 
выбранного типа объекта. Если выбран пункт «вставить из файла», то появится поле для 
ввода пути к файлу. При установке флажка Link(Связь с файлом) пути к файлу будут 
обновляться при изменении исходного файла. Например, в файл-заметку для задачи 
«создание рабочего комитета» можно вставить план первого заседания. А в задачу 
«Рассылка первого сообщения» можно вставить  замечание о списке рассылки. Список 
рассылки вставим в диаграмму как документ. Отформатировать его положение и вид на 
диаграмме можно в диалоговом окне форматирования. Чтобы вызвать контекстное меню, 
надо щелкнуть по объекту правой кнопкой мыши и выбрать команду 
Properties(Свойства).  
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Это окно состоит из двух вкладок. Положение определяется на вкладке 
Size&Position(Размер и положение). Его можно задать относительно шкалы времени, 
установив нужный переключатель, или относительно задачи. Если положение объекта 
связано со шкалой времени, то в поле Vertical(По вертикали) нужно указать расстояние 
между ней и объектом. Кроме того, в поле Date(Дата) нужно выбрать дату, под которой 
будет расположен объект. Если положение объекта связано с задачей, то в 
соответствующих полях указываются расстояния между отрезком задачи и объектом. А 
группа переключателей Attachment point(Точка привязки)  определяет, с какой стороны 
от отрезка будет расположен объект. Идентификатор задачи вводится в поле Id(Ид) . 
Размер объекта на диаграмме определяется полями раздела Size(Размер). На вкладке Line 
& Fill(Линии и заливка) можно указать особенности ограничения и закрашивания 
объекта. Кроме того, после того как объект вставлен, его можно перетащить мышью в 
другое место на диаграмме, или изменить размер рамок с помощью мыши.    

 Гиперссылки 
Гиперссылки можно создавать для задач, ресурсов и назначений. Особенно удобно 

это делать, когда документ слишком объемен, чтобы сохранять его в плане проекта. 
Откройте файл project.mpp. Для создания связи между гиперссылкой и объектом в плане 
(задачей, ресурсом, назначением), надо выделить строку с объектом и использовать 
команду Hyperlink(Гиперссылка) меню Insert(Вставка) или контекстного меню.  С 
помощью кнопок справа можно выбрать тип  ссылки: ссылка на файл в Интернете; ссылка 
на задачу, ресурс, или представление в текущем плане; ссылка на новый документ; ссылка 
для создания электронного сообщения. При создании ссылки на файл в интернете можно 
выбрать файл в текущей папке или в списке недавно открытых файлов. В поле Text to 
display(Текст) надо указать текст, который будет отображаться в виде ссылки. Можно 
также кнопкой Screen Tip(Подсказка) ввести текст, который будет появляться при 
наведении  курсора.   
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Интересна возможность ссылки на место в текущем документе.  В центральном 

окне будет отображен список представлений. Из них следует выбрать то, на которое 
создается ссылка. При этом можно указать идентификатор задачи или ресурса, 
выделяемый при открытии представления. Если ссылка создана, это будет отмечено в 
колонке (поле) индикаторов специальным значком.  

Настраиваемые поля 
 Не очень объемную информацию о задачах и ресурсах можно хранить в поле 
заметок. Это фактически настраиваемые текстовые поля, в них можно помещать 
фрагменты сопроводительного текста. Их главное преимущество состоит в том, что 
можно прикрепить к задаче внешние файлы или использовать команды форматирования 
текста. Однако структурировать, например, отфильтровать таблицу  по информации, 
содержащейся в заметках, невозможно.  

Использование настраиваемых полей позволяет легко структурировать 
информацию о задачах и ресурсах. Например, пусть возникла необходимость знать, что 
конкретно делается в ходе исполнения каждой из задач и какие результаты достигаются 
после ее завершения. Использовать заметки для хранения двух типов информации 
неудобно. Но можно создать два настраиваемых поля. Тогда по этим полям можно будет 
структурировать данные. И использовать их раздельно в дальнейшем.   
 Как создать настраиваемое поле рассмотрим на примере файла  project.mpp. Работа 
с настраиваемыми полями происходит в диалоговом окне Custom Fields (Настройка 
полей), его можно либо вызвать одноименной командой из контекстного меню при 
выделенной колонке, или   Tools > Customize > Fields (Сервис>Настройка> Поля). Во 
внутренние таблицы уже включен набор полей, которые можно настроить по своему 
способу. Эти поля могут относиться либо к ресурсам, либо к задачам, и отличаются они 
по типам данных, которые в них можно хранить.  
Типы настраиваемых полей 
 
Тип Макс. число 

полей  
Содержимое  поля 

Cost (Затраты) 10 Данные о стоимости задачи 
Date (Дата) 10 Даты 
Duration (Длительность) 10 Длительность, трудозатраты 
Finish (Окончание) 10 Даты 
Flag (Флаг) 20 Логические Yes(Да) или No(Нет) 
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Number (Число) 20 Числа  
Start (Начало) 10 Даты 
Text (Текст) 30 Текстовые данные 
Outline Code (Код структуры) 10 Структурированные значения 
 

Прежде чем выбирать тип поля, надо установить переключатель на задачи, или 
ресурсы. Затем выбрав нужный тип данных необходимо выбрать поле и настроить его 
нужным образом. Для того чтобы увидеть новое поле, не забудьте ввести его в таблицу 
(создать новую колонку). Для быстрого переименования и создания простого 
настраиваемого поля достаточно щелкнуть на его названии в списке настраиваемых полей 
и ввести новое название.  

     
   
Заполнять поля можно двумя способами. Первый, добавив его в таблицу,  

редактировать данные так же, как и во всех остальных полях. Второй, использовать 
вкладку Custom Fields(Настройка полей) диалогового окна сведений о задаче или 
ресурсе. На ней будут отображены  все уже  существующие поля.  

Отображать содержимое настраиваемого поля можно не только в таблице (создав 
новую колонку), но и прямо на диаграмме Ганта рядом с задачами. Сделать это можно в 
диалоговом окне настройки стилей отрезков. Оно открывается после двойного щелчка по 
отрезку левой кнопкой. В нем надо выбрать текстовую информацию и положение текста. 
Можно также изменить шрифт или его стиль.  

Использование формул.  
Особенно интересна и удобна возможность изменять значения настраиваемых 

полей автоматически с помощью формул. Например, введем поле с расчетом общего 
времени редактирования статьи. В нем мы будем подсчитывать произведение среднего 
времени редактирования одной страницы на число страниц. Не забудьте, что 
предварительно должны быть созданы два соответствующих настраиваемых  поля. 
Создадим еще одно  поле и в окне диалога выберем настраиваемый атрибут как формулу. 
Программа выдаст предупреждение, что для этого поля все ранее введенные данные могут 
быть утеряны.  Для  создания формулы  в нее можно подставлять существующие поля 
разного типа (кнопка Field) и заложенные в редактор функции. Кроме того, можно 
импортировать формулу из другого поля любого из открытых проектов.  
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 Суммарное поле всей фазы настраивается особым образом, если мы хотим, чтобы 
его значения автоматически  пересчитывались и для суммарных задач. Это можно сделать 
в разделе «Расчет для суммарных задач и групп» диалогового окна настройки полей. В 
этом разделе три переключателя. Если установить первый, то данные настраиваемого поля 
будут рассчитываться только для обычных задач. Второй переключатель позволяет 
рассчитывать значение настраиваемого поля для суммарных задач, использую одну из 
операций списка. Состав этого списка меняется в зависимости от типов полей, для 
текстовых полей он недоступен.   
Третий переключатель позволяет использовать для суммарного поля ту же формулу, 
которая задана для обычных задач. В нашем случае удобнее использовать не формулу, а 
операцию сложения значений настраиваемого поля для задач. Ведь в нашу формулу 
включены значения других полей. А значит, для них тоже надо настроить параметры 
определения значения этих полей для суммарных задач. Иначе значения этих полей для 
суммарных задач всегда будут нулевыми, и результат формулы будет нулем. Заметим 
еще, что фактически мы получили поле, отображающее трудозатраты соответствующих 
задач. В программе для подобной информации есть аналог, стандартное поле 
Work(Трудозатраты). Однако в него нельзя внести формулу, это не настраиваемое поле 
и данные в него можно вводить только вручную.  
 Модель, когда данные в поле автоматически пересчитываются, а потом их вносят 
вручную в план проекта, таит в себе опасность. Можно случайно забыть внести данные о 
трудозатратах в план проекта,  и он окажется неточным. Для устранения этой проблемы 
используют специальные поля - индикаторы.   
 
Операции для сведения данных в суммарных задачах 
 
Операция Типы полей 
 

Описание 
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And (И) Flag (Флаг) Логическое И. Если все 
вложенные строки в этом 
поле имеют значение Да, то 
результат операции – тоже 
Да. Если хотя бы одна из 
строк содержит значение Нет, 
то и результат логической 
операции будет Нет.   

Or (Или) Flag (Флаг) Логическое ИЛИ. Если хотя 
бы один из рядов содержит 
значение Да в этом поле, то 
операция сведения тоже даст 
Да.   

Average (Среднее) Cost(Стоимость), 
Duration(Длительность), 
Number (Число) 

Сведение будет средним по 
всем значениям вложенных 
несуммарных рядов. 

Average First Sublevel 
(Среднее первого 
подуровня) 

Cost(Стоимость), 
Duration(Длительность), 
Number (Число) 

Сведение будет средним по 
всем значениям вложенных 
несуммарных рядов и по всем 
значениям вложенных 
суммарных рядов первого 
уровня. 

Count All(Сложить все) Number (Число) При сведении будут 
складываться все суммарные 
и несуммарные ряды. 

Count First 
Sublevel(Сложить первый 
подуровень) 

Number (Число) При сведении будут 
складываться суммарные 
ряды первого уровня и все 
вложенные несуммарные 
ряды. 

Count Nonsummaries 
(Сложить несуммарные) 

Number (Число) При сведении будут сложены 
все несуммарные задачи. 

Maximum (Максимум) Cost(Стоимость), 
Duration(Длительность), 
Number (Число),  
Start (Начало),  
Finish (Окончание) 

Результатом сведения будет 
максимальное значение среди 
всех значений ниже. 

Minimum (Минимум) Cost(Стоимость), 
Duration(Длительность), 
Number (Число),  
Start (Начало),  
Finish (Окончание) 

Результатом сведения будет 
максимальное значение среди 
всех значений ниже. 

Sum (Сумма) Cost(Стоимость), 
Duration(Длительность), 
Number (Число),  
Start (Начало),  
Finish (Окончание) 

Результатом сведения будет 
максимальное значение среди 
всех значений ниже. 

 
Использование индикаторов.  
В настраиваемом поле  можно использовать не только текстовые и цифровые 

данные, но и рисунки. Это так называемые  цветовые индикаторы. Цвет индикатора 
зависит от выполнения или невыполнения логического условия. Откроем файл 
project.mpp. Создадим поле «обновлена». В принципе, индикатор можно отобразить и в 
самом поле «Общее время редактирования статьи», но мы создадим новое поле типа 
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«флаг», чтобы показать, как работать с полями такого типа. В диалоговом окне 
переименуем поле Flag1(Флаг1) в «Обновлена». Затем в окне настройки формулы для 
него введем формулу [Duration2]=[Work] ([Длительность2]=[Трудозатраты]). Поля-
флаги могут содержать только значение Yes «Да» или No«Нет». Если общее время 
редактирования статьи равняется трудозатратам, то поле будет содержать значение «Да». 
Для отображения индикатора в окне настройки поля выберем для Values to display 
(Отображаемые значения)  кнопку Graphical Indicators (Графические индикаторы). 
Откроется новое диалоговое окно. В нем настраиваются критерии отображения 
индикаторов для разных задач. В верхней части окна есть переключатель для типа задач 
(суммарные или не суммарные). Для каждого из них можно установить свои критерии. 
Если установлены оба флажка в этом переключателе, то тем самым, настраивая 
параметры обычных задач, вы автоматически  будете задавать параметры для всех 
остальных задач проекта. Настройка индикаторов производится в центре окна. В первой 
колонке выбирается логическая операция, во второй значение для проверки, и в последней 
рисунок индикатора. Проверка значения поля выполняется по очереди сверху вниз. Для 
перемещения условия по списку вверх или вниз служат стрелки сбоку.  

  
 
Если нужно увидеть значение поля, скрытого индикатором, то следует установить 

флажок Show data values in ToolTips (Показывать значения данных во всплывающих 
подсказках). Тогда данные будут отображаться при наведении курсора на индикатор. 
Иногда может произойти рассогласование данных индикаторов в файле. Дело в том, что 
для индикатора суммарной задачи необходимо задавать формулу расчета значения для 
суммарных задач. В противном случае получится, что его данные  можно будет 
редактировать. Чтобы сделать это перейдем в диалоговое окно настройки полей и 
выберем операцию суммирования для поля «Обновлена» в окне выбора задач. В нашем 
примере нам подходит логическая операция «И». Как выглядят результат сведения задач 
можно посмотреть на рисунке. Здесь у суммарной задачи «редактирование статей» 
индикатор красного цвета, поскольку у одной из подчиненных задач обновление не было 
сделано (это отмечено индикатором красного цвета для этой задачи).  
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Настраиваемые коды структур.        
 Можно различными способами организовать структуру проекта. Один из способов 
это иерархия вложенных заданий. Кроме того, можно упорядочивать задачи с помощью 
кода WBS. Иногда этих способов не хватает, и в этом случае можно создать собственные 
коды структур. Особенно удобна такая организация иерархии для ресурсов. Настроив 
нужные вам коды, вы можете в дальнейшем легко группировать ресурсы, например, по 
занимаемой должности, или по отделам. Подобную организацию информации очень 
удобно использовать при составлении отчетов или подведении итогов. 

Настраиваемые коды структуры создают в диалоговом окне настройки полей, при 
этом новые коды могут относиться и к задачам и к ресурсам. Тип поля нужно выбрать с 
помощью переключателя в верхней части вкладки. Затем из списка в диалоговом окне 
выбрать нужный Outline Code(Настраиваемый код),  для удобства его можно 
переименовать. Например, организуем для ресурсов настраиваемый код структуры по 
отделам и должностям. Новый код необходимо настроить. Для этого следует нажать 

кнопку Lookup (Подстановка) и в раскрывшемся окне, выбрав верхний блок Code Mask 
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(Маска кода), нажать на кнопку Edit Mask (Редактировать маску). Редактор маски кода 
выглядит также как для кода WBS. Точно также в нем можно задать несколько уровней 
кода, названия уровней, и формат данных. В нашем случае мы использовали символьные 
строки с неограниченным числом символов. После настройки маски кода мы вернемся в 
окно редактирования таблицы подстановки настраиваемого кода. В диалоговом окне 
можно редактировать два поля. Первое из них Outline Code(Настраиваемый код) 
содержит значения для подстановки, отображаемые в списке при заполнении поля. Второе 
поле называется   Description(Описание)  и содержит описание поля, или расшифровку 
кодов. Именно описание кода будет использовано программой при сортировке данных по 
коду, а также отображаться при их группировке.   
Если установить флажок в кнопке Use a value from a table as a default entry for the field 
(Использовать значение из таблицы как значение по умолчанию), то программа будет 
устанавливать выбранное значение по умолчанию для всех новых ресурсов. Существует 
также возможность сортировки по значениям кода при отображении в таблице. Для этого 
надо использовать кнопку Display order for lookup table (Порядок отображения в 
таблице подстановки).  Раздел Data entry options (Параметры ввода данных) позволяет 
при вводе нового ресурса использовать новые коды, еще не заданные в таблице 
подстановки. 

 
 
Название настраиваемого кода структур появится в списке настраиваемых полей 

после его создания. Значения его для каждого ресурса можно выбрать в раскрывающемся 
списке. В дальнейшем можно группировать ресурсы по этому полю.  
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Выполните лабораторные задания. 
 

Задание 1. Откройте учебный файл. Создайте в нем WBS (СДР) (при определении кода 
создайте не менее четырех уровней структуры). Перенумеруйте задачи.  
 
Задание 2. Попробуйте изменить код WBS для какой-нибудь задачи второго уровня, и 
посмотрите, каким образом изменятся коды у вложенных задач.  
 
Задание 3. Создайте текстовую заметку для задачи «первое заседание оргкомитета», 
содержащую повестку дня для заседания. 
 
Задание 4. Создайте заметку в диаграмме Ганта к задаче «рассылка первого сообщения», 
содержащую список рассылки и находящуюся в предварительно созданном файле. 
Отформатируйте объект ссылки, связав его с задачей.  
 
Задание 5. Создайте в диаграмме Ганта объект, связанный с датой.  
 
Задание 6. Создайте в задачах ссылки: 1) на страницу в Интернете; 2) на главного 
редактора (предварительно уточните его идентификатор) в представлении Resource 
Sheet(Лист ресурсов) этого проекта.   
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Лабораторная работа №5 Планирование стоимости проекта 

 
Методы планирования стоимости проекта 

Стоимость проекта может быть рассчитана различными способами.  Например, на 
основе анализа других проектов и расчета по аналогии. Или исходя из стоимости 
основных параметров проекта, например, строительных материалов и затрат на оплату 
работы. 

Стоимость проекта может быть рассчитана по принципу «сверху-вниз», когда 
исходя из общей стоимости проекта определяется стоимость отдельных задач. Или по 
принципу «снизу вверх», когда, наоборот, рассчитывается стоимость отдельных задач и, 
затем по их сумме вычисляется стоимость проекта. 

В среде MS Project используется последняя методика – расчет по принципу «снизу 
вверх». Она же является наиболее точной, хотя и наиболее трудоемкой.    

Cтоимость проекта в MS Project рассчитывается по следующим формулам: 
Общая стоимость проекта = Фиксированная стоимость ресурсов и задач + стоимость 
назначений. 
Стоимость назначения = стоимость ресурса * длительность назначения  (при почасовой 
ставке)    
или  
Стоимость назначения = фиксированная стоимость ресурса. 

Таким образом,  если для каждого ресурса определить затраты  на его 
использование, MS Project  автоматически рассчитает затраты для каждого назначения 
ресурсов на отдельные задачи, затем  рассчитает  сумму затрат для каждой задачи и, 
наконец, общие затраты на проект. 
 
В MS Project : 
Трудовые ресурсы – это люди, сооружения и оборудования.  
Особенность трудовых ресурсов в том, что после окончания задачи они не заканчиваются 
и могут быть назначены для исполнения  работы над другими задачами. 
Материальные ресурсы – это материалы и сырье. Они в процессе выполнения задачи 
используются полностью и после окончания не доступны для назначения другим задачам. 
 
Единичные и групповые ресурсы. 
Единичные ресурсы – это отдельные люди или оборудование. 
Групповые(обьединенные) ресурсы – это множество идентичных или 
взаимозаменяемых ресурсов.   Например: редакторы или секретари.  Все отдельные 
ресурсы, входящие в обьединенный ресурс, должны иметь одинаковые затраты и 
использовать один календарь ресурсов, определенный для этой группы.  Нельзя для них 
назначать отдельные ставки и указывать отдельное нерабочее время. 
 
Различают затраты: фиксированные, на трудовые ресурсы и общие 
Фиксированные затраты – это затраты, связанные с задачей напрямую. Например: 
сборы на получение разрешения на  строительство. 
Затраты на трудовые ресурсы  - это затраты каждого ресурса, назначенного задаче. 
Связаны со временем работы или с усилиями, затраченными на назначение и с затратами 
времени использования ресурса. 
Общие затраты – сумма затрат на ресурсы и фиксированных затрат. 
Вычисление  затрат на трудовые ресурсы 
Затраты на трудовые ресурсы вычисляются по формуле 
Затраты на ресурсы= затраты единицы времени ресурса *  количество времени, которое 
ресурс тратит на выполнение задачи. 
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 Например: если ресурс стоит 50 руб. в час. и назначен на 5 часов, то затраты на ресурс 
составят 250 руб. 
  
Как вычисляются  затраты на задачу? Если задаче назначить несколько ресурсов, то 
затраты на задачу будут равны сумме затрат назначений. 
Как вычисляются затраты на материальные ресурсы? Затраты на материальные 
ресурсы прямо не связаны с длительностью задачи, не зависят от нее. 
Затраты на материальные ресурсы = количество единиц ресурса * затраты единицы 
ресурса. 
Например: количество  метров ткани * затраты на метр ткани 
Определение стоимости ресурсов 
В среде MS Project стоимость использования ресурса определяется в окне Resource 
information (Информация о ресурсе) на вкладке Costs (Затраты) посредством ввода 
значений в Таблицы норм затрат. 
В  разделе Cost rate table (Таблицы норм затрат) имеется  5 таблиц норм затрат с 
одинаковой структурой - содержат   вкладки A, B, C, D и E. 
 

 
 
 
В таблице для ресурса в формате число/единица времени можно указать ставки оплаты 
ресурса: 
 Стандартная ставка (поле Standart Rate ) - для работы в обычное рабочее время 
 Ставка сверхурочных (поле Overtime Rate (для работы в сверхурочное время) 
 Затраты на использование (поле Per Use Cost) (специальные затраты на назначение, 

которые не зависят от количества рабочих часов) 
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Ставки вводятся в формате:     число/единица времени. Например, 1000$ /mo (1000$/мес) –  
что соответствует 1000 доллларов за месяц трудозатрат. 
 
Ставки ресурса могут изменяется во время исполнения проекта.   В поле  Effective Date 
(Дата действия) можно указать дату, с которой действуют новые ставки оплаты ресурса. 
Поле Effective Date можно  заполнять, только начиная со 2-й строки таблицы. Ставки 
можно указывать как в абсолютном числовом значении, так и в процентном отношении от 
значения в предыдущей строке. Например, +10%. 
 
Для материальных ресурсов ставки использования вводятся без единиц измерения этих 
ресурсов. Введенное значение система рассматривает, как стоимость одной единицы 
материального ресурса (например, коробки). 
 
Расчет стоимости назначения 
 
При назначении ресурса на задачу его стоимость вычисляется автоматически по формуле:  
 
Стоимость назначения =  ставка ресурса * трудозатраты +  затраты на использование 
ресурса. 
 
При этом по умолчанию ставка ресурса берется из таблицы норм затрат А. При 
необходимости для расчета можно указать другую таблицу норм затрат. 
Для этого  нужно открыть окно Assignment Information(Информация о назначении), 
щелкнув по имени ресурса в окне Task Usage(Использование задач)  
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и на вкладке General (Общие) диалогового окна сведений о назначении выбрать в списке 
Cost rate table(Таблица норм затрат) альтернативную  таблицу норм затрат. Это вызовет 
соответствующее изменение  стоимости назначения. 
 
Расчет стоимости задач 
 
В среде MS Project cтоимость задачи рассчитывается по формуле: 
Стоимость задачи =  сумма стоимости назначений + фиксированные затраты. 
 
Фиксированные затраты (fixed cost) – это затраты, не связанные с использованием 
проектных ресурсов. Они не зависят от трудозатрат.  
 
Можно ввести фиксированные затраты в поле Fixed Cost (Фиксированные затраты )в 
таблице Cost (Затраты). Чтобы открыть таблицу Cost (Затраты) нужно выбрать из меню 
View-> Table -> Cost. 
 
 

 
 
Методы начисления затрат 
 
При планировании стоимости проекта необходимо определить режим расходования  
бюджета на протяжении проекта. Для этого надо назначить порядок или способ оплаты 
работ. 
 
Способы оплаты работ могут быть следующие:  
 

 предоплата, 
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 оплата по факту завершения работ, 
 оплата по мере выполнения работ. 

 
Способы оплаты могут сочетаются. 
 
Для указания способа оплаты нужно выбрать вкладку Cost (Затраты) в окне Resource 
Information (Информация о ресурсе)и   сделать назначение в списке Cost Accrual 
(Начисление затрат): 
 

 Start (Оплата в начале проекта ),  
 End (Оплата по окончании проекта),  
 Prorated (Пропорциональная оплата в период проекта). 

 

 
 
 
 
Метод начисления фиксированных затрат указывается в поле Fixed Cost Accrual 
(Начисление фиксированных затрат) для каждой задачи.   По умолчанию – в списке 
Default  Fixed Cost Accrual  на вкладке Calculation в окне  Tools/Options.  
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Выполните лабораторные задания. 

Задание 1.    Для каждого ресурса, обозначенного в проекте,  определите  затраты  на его 
использование.  Для этого выполните следующее: 

 выделите ресурс и откройте окно Resource information (Информация о ресурсе); 
 откройте вкладку Costs (Затраты);  
 в  Таблицы норм затрат А и В в формате укажите ставки оплаты ресурса: 

стандартную ставку (поле Standart Rate), ставку сверхурочных (поле Overtime Rate), 
затраты на использование (поле Per Use Cost). 

Задание 2.  Используйте поле  Effective Date (Дата действия) и следующие, начиная со 
второй, строки таблицы для указания даты и  новых ставок оплаты ресурса. 
Задание 3. Назначьте ресурсы на задачи.  При назначении ресурсов указывайте Таблицу 
норм затрат А.   Посмотрите, как система рассчитает стоимость назначения каждого 
ресурса. 
Задание 4. Измените параметры назначения ресурсов: в окне назначении ресурсов 
Assignment Information(Информация о назначении) укажите другую Таблицу норм затрат 
В.   Посмотрите, как изменится  стоимость назначения каждого ресурса. 
Задание 5.  Измените ставки оплаты ресурса. Посмотрите, как изменится  стоимость 
назначения каждого ресурса. 
Задание 6.  Измените Фиксированные затраты (fixed cost) на задачу. Используйте для 
этого  поле Fixed Cost (Фиксированные затраты )в таблице Cost (Затраты).   Посмотрите, 
как рассчиталась стоимость задачи. 
Задание 7. Определите режим расходования  бюджета в течение проекта. Назначьте 
порядок оплаты работ.  Посмотрите, какие изменения в проекте вызывает смена способа 
оплаты работ. 
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Лабораторная работа №6 Анализ доступности ресурсов 
 
Доступность ресурса. Расчет доступности ресурса. 
Доступность ресурса  есть  максимальная способность ресурса выполнять работу. 
В среде  MS Project доступность ресурса контролируется при помощи параметра  
Максимальные единицы (Max.Units). 
Максимальные единицы могут выражаться: 

 в числах (например, 3 единицы) или  процентах (300% единиц) 
 
Количество времени, которое ресурс доступен во время проекта, определяется 
следующими значениями: 
 

 количество единиц ресурса, доступных в определенный период времени 
 
 
доступность ресурса по времени настраивается на сетке Resource Availability во вкладке 
Общие (General)  окна Сведения о ресурсе (Resource Information) 
 

 
 

 количество рабочего времени, которое указано в календаре ресурса  для 
определенного периода времени.   Определяется в окне Change Working Time 
(Рабочее время) диалогового окна Resource Information (Сведения о ресурсе). 
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Рассчитать доступность ресурса можно по формуле: 
Обьем работы, для которого ресурс доступен в данный период времени = 
Количество доступных единиц ресурса * рабочее время в календаре для данного периода 
времени. 
Например: 
 
Вариант расчета                                                                   1                     2                   3 
Максимально доступное количество                               100%            100%              300% 
единиц ресурса                                                         (1 единица)   (1 единица) (3 единицы) 
--------------------------------------------------------------------------------------------------------------- 
Рабочее время в календаре                                           8 часов            4 часа            8 часов 
--------------------------------------------------------------------------------------------------------------- 
Максимально возможное рабочее время                    8 часов            4 часа            24 часа 
в сутки 
 
 
Распределение трудоспособности ресурса по времени называется выделением ресурса 
(allocation). 
 
Cуществует три состояния ресурса: 
 

• С неполным выделением (underallocated) 
• С полным выделением      (fully allocated) 
• C превышением доступности (overallocated) 
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Ресурс находится в состоянии с неполным выделением (underallocated), если 
максимальная производительность ресурса не заполнена назначениями. 
Например, назначения ресурса, работающего на полную ставку, занимают только 30 часов 
40-часовой рабочей недели. 
 
Ресурс находится в состоянии  с полным выделением   (fully allocated), если максимальная 
производительность ресурса точно заполнена назначениями. 
Например, назначения ресурса, работающего на полную ставку, занимают 40 часов 40-
часовой рабочей недели. 
 
Ресурс находится в состоянии  с превышением доступности (overallocated), если 
максимальная производительность ресурса превышена назначениями. 
Например, назначения ресурса, работающего на полную ставку, занимают 70 часов 40-
часовой рабочей недели. 
 
 
Причины возникновения превышения доступности ресурса. 
 

Таким образом, превышение доступности ресурса – это назначение ресурсу в 
течение определенного периода времени часов работы больше, чем доступно в рамках 
проекта.  
 

Превышение доступности ресурса может возникать, например, по следующим 
причинам:  

 назначение ресурса на задачи, исполнение которых полностью или частично 
осуществляется одновременно; 

 увеличение обьема работ задачи, приведшее к превышению допустимого уровня 
загрузки ресурса; 

 назначение ресурса на дни, когда ресурс недоступен. 
 

В среде MS Project превышение доступности ресурса может возникать обычно как 
следствие  планирования нескольких назначений ресурса на одно и тоже время.  При 
планировании назначений MS Project  автоматически использует календарь ресурса 
вместо основного календаря проекта  и планирует назначение на время, которое в 
календаре ресурса является: 

 ближайшим доступным,  
 удовлетворяющим требуемым условиям.  

 
При этом проверка, не назначен ли ресурс на это время другим задачам,  системой не 
производится. 
 
Какой календарь MS  Project будет использовать  при планировании, регулируется 
посредством опции Scheduling Ignores Resource Calendars (Не учитывать календари 
ресурсов при планировании). При включении этой опции календарь ресурса будет 
игнорироваться и будет использоваться календарь задачи. Возникающее при этом 
превышение доступности ресурса MS  Project таковым считать не будет. 
 
Распределение часов рабочего времени в течение какого периода, например, недели, 
может быть таковым, что превышение доступности ресурса будет иметь место для какого-
то отдельного дня  в неделе при отсутствии превышения доступности по сумме часов за 
неделю.  Например: 
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Назначение ресурса Соколов С. на неделю: 
                                                            Пон       Вт        Ср        Чт         Пт          Итого  
                                                                                                                               за неделю 
Макс. Единиц (Max Units)               100%    100%   100%   100%    100% 
 
Рабочее время                                    8 час     8 час    8 час    8 час     8 час         40 час 
--------------------------------------------------------------------------------------------------------------- 
Задача А   Единицы                          100%    100% 
Задача А   Трудозатраты                   8 час     8 час 
 
Задача Б   Единицы                                                    100%  100% 
Задача Б   Трудозатраты                                             8 час   8 час 
 
Задача В   Единицы                                                                25%          
Задача В   Трудозатраты                                                         2 час 
 
--------------------------------------------------------------------------------------------------------------- 
Общее количество единиц            100%    100%    100%   125%        0% 
Общий объем работы                      8 час     8 час     8 час  10 час       0 час        34 час 
Превышение доступности              Нет       Нет       Нет     Да            Нет           Нет 
 
 
Просмотр превышения доступности ресурсов.  
 
Ресурсы с превышением доступности можно просматривать в представлениях Resource 
Sheet (Лист ресурсов), Resource Usage (Использование ресурсов) и Resource Allocation 
(Выделение ресурсов).  
 
По умолчанию ресурсы с превышением доступности MS Project  выделяет шрифтом 
красного цвета. 
 
В MS Project есть несколько полей, значимых с точки зрения превышения доступности 
ресурсов.Это: 

 поле Max.Units (Максимальных единиц); 
 вычисляемое поле Peak (Пиковая нагрузка).  
 поле Overallocated (Превышение доступности) 
 

В том случае, если  значение поля Peak (Пиковая нагрузка), которое содержит 
максимальное количество одновременно назначенных единиц для каждого периода 
времени, превышает значение поля Max.Units (Максимальных единиц) в любой момент 
времени, то вычисляемое поле Overallocated (Превышение доступности) содержит 
значение Yes (иначе содержит No)  и ресурс выделяется красным цветом. 
 
Превышение доступности ресурса означает, что ресурс не может выполнить назначенную 
ему работу, и ситуации требует корректирования. 
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Фильтрация ресурсов с превышением доступности. Критерий «чувствительности 
выравнивания». 

Список ресурсов с превышением доступности можно отфильтровать. Для этого можно 
применить фильтр Overallocated Resources: (Project -> Filtered For -> Overallocated 
Resources). 

 

 49



Чтобы снять фильтр, нужно выполнить: 
(Project -> Filtered For -> All Resources).  
 
Возможно, что не все случаи превышения доступности ресурсов, которые имеют место 
в плане проекта, заслуживают расмотрения и исправления. Какие случаи необходимо 
отфильтровать, чтобы рассмотреть и исправить, можно определить при помощи так 
называемого «критерия чувствительности выравнивания». 
Этот критерий указывает временные рамки, в которых нужно искать превышение 
доступности: по дням, неделям, минутам и т.д. 
Критерий чувствительности можно установить в диалоговом окне Resource Leveling 
(Выравнивание загрузки ресурсов). Для этого надо выбрать команду Tools->Level 
Resources (Выравнивание загрузки ресурсов) и установить значение в поле Look for 
Overallocation on a (Поиск превышений доступности) выбором из множества значений:  

 Minute by Minute (По минутам),  
 Hour by Hour (По часам),  
 Day by Day (По дням),  
 Week by Week(По неделям),  
 Month by Month(По месяцам)  

  
  
 
 
 
 

 

 
 
В рассмотренном выше примере превышение доступности ресурса Соколов С. имеет 
место в день недели (в четверг). Поэтому при при установке значения параметра критерия 
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чевствительности Day by Day (По дням), в строке рядом с ресурсом отобразится 
индикатор Leveling (Выравнивание), а при установке значения Week by Week(По неделям) 
индикатор отображаться не будет. 
Текущее значение параметра чувствительности высвечивается при наведении указателя 
мыши на  индикатор Leveling (Выравнивание). 
 
Представление Resource Usage (Использование ресурсов). 
 
Представление Resource Usage (Использование ресурсов) удобно и полезно тем, что 
отображая большое количество данных о назначении ресурсов, оно представляет также 
повременные подробности для каждого периода времени на шкале времени с 
возможностью редактирования некоторых из них.  

 
 
 
 
 
Например, такие подробности, как  сверхурочные трудозатраты,  затраты, количество 
доступных единиц, пиковые единицы  ориентировочный и фактически выполненный 
объем работы). 
Также  в этом представлении для каждого назначения можно просмотреть  поля Work 
(Трудозатраты) и Peak (Пиковые единицы) и их суммы для каждого ресурса. 
При этом, устанавливая на шкале времени единицу времени, можно отображать  
подробности назначения в масштабе времени по минутам, месяцам, кварталам или годам. 
В представлении Resource Usage (Использование ресурсов) можно произвести поиск 
очередного периода времени, в котором произошло превышение доступности ресурса. 
Для этого требуется отобразить панель  Управление ресурсами  (View->Toolbars-
>Resource Management) и использовать инструмент Go to Next Overallocation (перейти к 
следующему превышению доступности). 
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Также этот инструмент можно использовать в представлениях Gantt Chart (Диаграмма 
Ганта) и Task Sheet(Лист задач), отображающих списки задач, для выбора и выделения  
задач с ресурсами, доступность которых превышена.  
Превышение доступности ресурса также можно отобразить графически, используя 
представление Resource Graphs (График ресурсов). 
 
 

 
 
Выполните лабораторные задания. 
 

Задание 1.  Для каждого ресурса в проекте проверьте уровень его доступности. Для этого 
выделите ресурс, откройте окно Resource Information (Сведения о ресурсе), вкладку 
General, проверьте значения в таблице Resource Availability. 
Задание 2. Рассчитайте доступность ресурса по формуле: 
Обьем работы, для которого ресурс доступен в данный период времени = 
Количество доступных единиц ресурса * рабочее время в календаре для данного периода 
времени. 
Задание 3. Оцените распределение трудоспособности ресурса по времени.  
Задание 4. Измените календарь ресурса. Посмотрите, как скажутся эти изменения на 
доступности ресурса. 
Задание 5. В случае возникновения превышения доступности ресурса, проверьте, для 
какого периода времени оно имеет место: для отдельного дня, месяца, недели. 
Задание 6. В представлениях Resource Sheet (Лист ресурсов), Resource Usage 
(Использование ресурсов) и Resource Allocation (Выделение ресурсов) проверьте 
состояние  полей   Max.Units (Максимальных единиц), Peak (Пиковая нагрузка),   
Overallocated (Превышение доступности). Посмотрите, как соотносятся значения в этих 
полях.  Определите, в  каких случаях    поле Overallocated (Превышение доступности) 
принимает значение Yes и ресурс выделяется красным цветом. 
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Задание 7.  Отфильтруйте список ресурсов с превышением доступности.  Разберитесь, как 
влияет установка  «критерия чувствительности выравнивания» на индикатор Leveling 
(Выравнивание).   
Задание 8. Исследуйте, как графически отображается  превышение доступности ресурса в 
представлении Resource Graphs (График ресурсов).  
 
Лабораторная работа №7 Оптимизация плана проекта 

 
Следствия превышения доступности ресурсов. 
Наличие в плане проекта ресурсов с превышением доступности отрицательно скажется на 
исполнении проекта, так как ресурсы не смогут выполнить в установленный планом срок 
назначенный им обьем работы. 
Это проявится в следующем:  

 работа вообще не будет выполняться или; 
 работа будет незакончена или; 
 работа будет перенесена на более позднее время.  

Поэтому превышение доступности ресурсов в плане проекта необходимо устранить 
возможными способами. 
Способы устранения перегруженности  ресурсов. 
Устранить превышение доступности ресурсов можно следующими способами, применяя 
их по отдельности или в сочетании друг с другом: 
 

 увеличить доступность перегруженного ресурса для данного периода времени; 
 уменьшить обьем работы перегруженного ресурса;  
 назначить  других сотрудников на  выполнение задач, перегружающих ресурс; 
 изменить сроки выполнения (даты начала и окончания) задач, требующих 

ресурсов с недостаточной доступностью;  
 обозначить обьем работы, превышающий доступность ресурса, как 

сверхурочную работу. 
В среде MS Project превышение доступности ресурсов можно устранить автоматически, 
используя встроенный режим выравнивания, или вручную, изменяя параметры ресурсов, 
назначений и задач. 
 
Автоматическое выравнивание загрузки ресурсов 
Для того, чтобы выровнять загрузку ресурсов автоматически, можно использовать 
специальный механизм MS Project, предварительно настроив его параметры следующим 
образом. 
При помощи меню Tools/Level Resources (Сервис/Выравнивание загрузки ресурсов) 
откройте окно Resource Leveling. 
Окно содержит три раздела: 

 Leveling Calculation (Вычисления для выравнивания) 
 Leveling range for (Диапазон выравнивания для проекта) 
 Resolving Overallocations (Устранение превышений доступности) 

В каждом разделе содержится свой набор параметров.  Рассмотрим разделы. 
Раздел Leveling Calculation (Вычисления для выравнивания) 
В этом разделе устанавливается режим выравнивания загрузки ресурсов выбором из 
списка: 

 Automatic (Выполнять автоматически)  -  выполняется при щелчке по кнопке Level 
Now (Выровнять). 

 Manual (Выполнять вручную)   -   выполняется непосредственным исправлением 
назначений 
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В списке Look for overallocations (Поиск превышений доступности) определяется 
критерий «чувствительности выравнивания» или временные рамки, в которых программа 
будет искать превышение доступности ресурса. Возможные значения: 

 Hour by hour (По часам) 
 Day by Day  (По дням) 
 Minute by Minute (По минутам) 

 
Какое из этих значений выбрать в списке, определяется подсказкой, всплывающей  при 
наведении указателя мыши на индикатор выравнивания, расположенный в строке   слева 
от перегруженного ресурса. Например, если всплывает подсказка о том, что ресурс 
должен выравниваться по дням,  в списке Look for overallocations (Поиск превышений 
доступности)  нужно выбрать значение  Day by Day  (По дням).   
 
До очередного запуска процесса выравнивания можно отменить результаты предыдущего 
выравнивания. Это делается  установкой флажка Clear leveling values before leveling 
(Очистка данных прежнего выравнивания перед новым). В этом случае перед 
проведением очередного  выравнивания  изменения предыдущего удаляются.  Флажок 
рекомендуется устанавливать. 
 
Раздел Leveling range for (Диапазон выравнивания для проекта) 
 
В разделе Leveling range for (Диапазон выравнивания для проекта) можно определить 
временной интервал, в котором будет производиться выравнивание: 

 Level entire project (Выравнивание во всем проекте).  Поиск превышений 
доступности производится в интервале с начала до конца проекта. При этом можно 
указать выравнивание не для всех, а только для выделенных ресурсов. 

 Level from … to … (Выравнивание в диапазоне дат). Поиск превышений 
доступности производится только в указанном  диапазоне дат. Превышения 
доступности ресурсов за пределами указанного диапазона не устраняются. 

 
Раздел Resolving Overallocations (Устранение превышений доступности) 
 
В разделе Resolving Overallocations (Устранение превышений доступности) определяется, 
как программа будет устранять найденные перегрузки ресурсов. 
Сначала программа определит список задач, на которые назначены перегруженные 
ресурсы. Затем будут отобраны те задачи, расположение которых в расписании нужно 
изменить. Порядок, в котором MS Project будет откладывать или прерывать задачи, 
перегружающие ресурсы, определяется в списке Leveling order(Порядок выравнивания): 
 
Список Leveling order содержит три возможных значения: 

 ID Only (только по идентификаторам) – в первую очередь будут изменяться 
параметры задач с наибольшими идентификаторами, то есть тех задач, которые  
расположены ниже в списке.  Если список задач составлен в порядке возрастания 
даты начала, значит, будут откладываться задачи с более поздней датой начала. И, 
число задач-последователей, на которые может повлиять процедура выравнивания, 
будет, таким образом,  сводится к минимуму. 

 Standard (Стандартный). Программа из конкурирующих задач выбирает, какую 
выравнивать первой,   на основе анализа ряда факторов (см. ниже). При этом  MS 
Project рассматривает  взаимосвязи с другими задачами, общий временной резерв, 
даты, приоритеты и ограничения. В первую очередь откладываются задачи с 
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наибольшим временным резервом  и более поздней датой начала. Такой  порядок  
выравнивания используется наиболее часто. 

  Priority, Standart (По приоритетам, стандартный). Производится аналогично 
стандартному, но обычно используется, если при составлении плана у задач 
определялось свойство Priority(Приоритет). Отличается от Стандартного тем, что 
при анализе задачи сначала сортируются по приоритету.  

 
 
Факторы, которые рассматриваются при Стандартном и Стандартном по 
приоритетам порядках выравнивания загрузки ресурсов  
 
Выравнивая загрузку ресурсов в указанных режимах MS Project анализирует следующие 
факторы (расположены в порядке убывания важности): 

 Predecessors (Предшественники).  Первыми выбираются задачи, не имеющие 
последователей. 

 Amount of total slack (Размер полного резерва). Первыми выбираются задачи с 
большим количеством полного резерва. 

 Start date (Дата начала). Задачи с более поздней датой начала задерживаются 
первыми. 

 Priority (Приоритет). Первыми выбираются задачи с более низким приоритетом. В 
случае режива выравнивания Стандартного по приоритетам, этот фактор 
рассматривается первым.  

 Constraints (Ограничения). Сначала задерживаются задачи без ограничений. 
 Поле ресурса Can Lavel (Может выравниваться). Если значение поля   установлено 

в Yes, то MS Project при необходимости может задерживать назначение данного 
ресурса. Для ресурсов, назначение которых задерживать нельзя, необходимо 
установить значение поля  No. 

 Поле задачи Level Assignments (Выравнивать назначения). Если значение поля   
установлено в Yes, то MS Project при необходимости может задерживать 
назначения данной задачи. Для задач, назначения которых задерживать нельзя, 
неоходимо установить значение поля  No. 

 Поле задачи Leveling Can Split (Выравнивание можно прерывать). Если значение 
поля установлено в Yes, то MS Project может при необходимости разделять задачи. 

 
Важные замечания: 
1. Производя выравнивание, MS Project никогда не будет прерывать или откладывать 
задачи, для которых: 

 назначено значение  приоритета  1000,  
 установлены ограничения   Must Start On (Фиксированное начало) и Must Finish On 

(Фиксированное окончание).  
2. Выравнивание  не повлияет на задачи с ограничениями:  

 As Late As Possible (Как можно позже), если проект планируется от даты начала  
 As Soon As Possible (Как можно раньше), если проект планируется от даты 

окончания. 
3. Приоритет может быть установлен не только для задачи, но и для проекта. Если 
ресурсы назначены нескольким проектам, то задачи в проектах с меньшим приоритетом 
будут выбираться для выравнивания чаще, чем задачи в проектах с большим приоритетом. 
Если для проекта задать приоритет 1000, значит, ни одна задача этого проекта не будет 
задержана при выравнивании.  
4. Приоритет проекта более значим, чем приоритет задачи. Любая  задача проекта с 
большим приоритетом более приоритетна, чем задача проекта с меньшим приоритетом. 
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Это справедливо независимо от значения приоритета, установленного для задачи, кроме 
задач с приоритетом 1000, которые не задерживаются никогда. 
Установить значение приоритета для задачи можно на вкладке General (Общие) окна Task 
Information (Сведения о задаче) в поле Priority (Приоритет). Значение приоритета может 
варировать в интервале от 0 (при необходимости скорее всего будет задержана) до 1000 
(не будет задержана никогда). Чем больше приоритет, тем меньше вероятность задержки 
задачи при выравнивании. 
 

 
 
 
     В результате автоматического выравнивания может измениться дата окончания 
проекта. Возможность такого изменения регулируется при помощи флажка Level only 
within available slack (Выравнивание только в пределах имеющегося резерва). Если 
флажок установить, то в результате выравнивания дата окончания проекта не изменится, 
но некоторое ресурсы при этом останутся перегруженными и исправлять это придется  
вручную.  Если флажок сбросить, то дата может измениться, и длительность проекта 
может увеличиться. 
 
Для того, чтобы в процессе выравнивания изменялось свойство  только назначений, а не 
задач, нужно установить флажок Leveling can adjust individual assignment on a task (При 
выравнивании допускается коррекция отдельных назначений для задачи). Если флажок 
сбросить, то будут изменять свойства задачи.   
 
Действие флажка можно распространить не на все задачи.  Для этого в таблицу со 
списком задач нужно добавить поле Level Assigment (Выравнивание назначений) и 
указать в этом поле для нужных задач значение Yes или No.   Добавить поле в таблицу 
можно, выбрав в меню :  Insert/Column 
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При выравнивании программа может прерывать задачи. Это можно разрешить или 
запретить установкой флажка Leveling can create splits in remaining work (При 
выравнивании допускается прерывание оставшихся трудозатрат).   
Действие этого флажка также можно распространить не на все задачи. Для этого  в 
таблицу со списком задач нужно добавить поле Leveling Can Split (Допускается 
прерывание при выравнивании) и указать в этом поле для нужных задач соответствующее 
значение. 
Чтобы сохранить настройки выравнивания, щелкните Ok. 
Чтобы начать выравнивание, нужно щелкнуть по кнопке Level Now (Выровнять). 
Если процесс выравнивания запущен в представлении задач, программа произведет 
выравнивание без выдачи дополнительного сообщения. 
Если процесс выравнивания запущен в представлении ресурсов, то программа уточнит, 
какие ресурсы выровнять – все или только выделенные на листе. 
Выбором Entire pool (Весь пул) задается режим, при котором будут выровнены все 
ресурсы и задачи, связанные с превышением доступности. 
Выбором Selected resources (Выбранные ресурсы) задается режим, при котором будут 
выровнены назначения только выделенных ресурсов. 
Результаты выравнивания отражаются как в списке ресурсов, так и в календарном 
плане  проекта.    В списке ресурсов может уменьшиться число перегруженных ресурсов.   
В календарном плане может измениться время выполнения задач. 
Чтобы понять, как выравнивание повлияло на календарный план проекта, удобно 
использовать представление Leveling Gantt (Диаграмма Ганта с выравниванием). 
На диаграмме представлены два вида отрезков.  В отрезках сине-черного цвета 
отображается текущий план проекта,  зеленого – состояние плана до выравнивания. 
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Тонкие новые отрезки на диаграмме обозначают задержку задачи, которая произошла  в 
результате выравнивания.    
Delay – задержка   (отображается зеленым цветом) 
Slack – временной резерв, то есть время, на которое задача может быть отложена 
(отображается коричневым цветом). 
 
В представлении рядом с диаграммой отображается таблица Delay (Задержка), 
содержащая столбец Leveling Delay (Выравнивающая задержка). В этом столбце показано 
время, на которое была отложена  задача в результате выравнивания. Это время 
измеряется в единицах с префиксом  е (n), что означает elapsed (прошедший), например, 
2ed (2 пд) – два прошедших дня. 
 
Столбцы Start и  Finish, отображаемые в таблице,  обозначают начало и окончание задач 
после выравнивания. Дата начала и окончания задач  до выравнивания выводятся в 
столбцах Preleveled Start (Начало до выравнивания) и Preleveled Finish (Окончание до 
выравнивания). Кроме того, информация об этих датах отображается во всплывающих 
подсказках при наведении указателя мыши на отрезки диаграммы. 
 
Чтобы просмотреть на диаграмме Ганта как изменились отдельные назначения, можно 
разделить окно и в нижней его  части открыть представление Task Usage (Использование 
задач). Тогда, выделив задачу в верхнем представлении, в нижнем можно просматривать 
загрузку ресурсов за каждый день на всем ее протяжении.  
 
Если в процессе выравнивания программа определит, что для каких-то назначений  
выровнять загрузку ресурсов автоматически невозможно, то на экран будет выведено 
диалоговое окно с соответствующим сообщением: 
 

 

 58



 
В диалоговом окне нужно сделать выбор варианта развития событий: 

 Skip (Пропустить).  MS Project пропускает ресурс и продолжает поиск очередного 
превышения доступности 

 Skip All (Пропустить все). MS Project пропускает все превышения доступности, 
которые не может разрешить,  и  сообщение на экран больше не выводится. 

 Stop (Остановить).  Команда остановить процесс выравнивания и удалить все 
сделанные задержки. 

Отменить результаты автоматического выравнивания полностью или частично можно с 
помощью кнопки Clear Leveling (Очистить выравнивание) в диалоговом окне 
выравнивания загрузки ресурсов. 
Выравнивание можно отменить только для некоторых задач. Для этого можно выделить 
эти задачи мышью при нажатой клавише CTRL перед тем, как открыть диалоговое окно. 
После щелчка на кнопке  Clear Leveling программа откроет окно, в котором нужно 
выбрать область действия отмены: 
 
Entire project – Для всего проекта 
Selected Tasks  - Для выбранных задач. 
 
Важные замечания:  

1. Отменить результаты выравнивания можно только для последней операции 
выравнивания. 

2. Автоматическое выравнивание загрузки ресурсов имеет свои недостатки. В 
процессе выравнивания MS Project не исследует все возможные комбинации 
на предмет поиска оптимального решения задержек задач, лучшего с точки 
зрения минимизации затрат и(или) поиска самой ранней даты окончания 
проекта.  Решения которые принимает человек, выравнивая загрузку 
ресурсов вручную, могут быть более эффективными по сравнению с 
решениями MS Project. 

 
 
 
Ручное выравнивание загрузки ресурсов. 
 
В отличие от автоматического выравнивания загрузки ресурсов, при котором MS Project 
применяет единственную стратегию, а именно задержку назначений и откладывание 
задач,  при ручном выравнивании загрузки ресурсов можно применить несколько 
способов или стратегий, сочетая их.  Способы следующие: 
1. Увеличить доступность ресурса путем: 

 изменения параметров доступности ресурса; 
 планирования сверхурочного времени для ресурса; 
 увеличения доступного времени в календаре ресурса. 

 
2. Сократить нагрузку на ресурс путем: 

 переназначения части нагрузки ресурса другим ресурсам; 
 откладывания отдельных назначений; 
 откладывания задач; 
 прерывания отдельных назначений; 
 прерывания  задач; 
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Увеличение доступности ресурса. 
 

Корректирование параметров доступности ресурса. 
 
Для увеличения доступности ресурса можно изменить следующие его параметры: 

 увеличить период времени, когда доступен ресурс; 
 увеличить количество единиц ресурса, доступных в нужные периоды времени. 

 
Эти изменения производятся  в окне Resource Information (Сведения о ресурсе) в таблице 
Resource Availability (Доступность ресурса) в столбцах Available To (Доступен по) и 
Units (Единицы) соответственно. 
 
 
 

  
 

Планирование сверхурочного времени для ресурса 
 

Снизить нагрузку на ресурс можно, введя для него некоторое количество часов 
сверхурочного времени. При этом не потребуется менять общий объем работы, 
запланированный на обычное рабочее время. При расчете MS Project  будет вычитать 
часы, запланированные, как сверхурочные, из общего объема работы. Издержки этого 
метода в том, что сверхурочная работа оплачивается дороже. Но затраты могут оказаться 
ниже, чем они могли бы быть при привлечении нового ресурса.  Порядок работы MS 
Project при использовании сверхурочного времени будут следующий: 

 обычное рабочее время рассчитается вычетом из общего времени назначения 
введенного сверхурочного времени; 
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 полученное количество обычных рабочих часов будет спланировано на доступное 
в календаре рабочее время, что уменьшит длительность назначения; 

 сверхурочное время будет равномерно распределено по новой длительности 
назначения.   

 
 
Сверхурочное время можно ввести в представлении Resource Usage (Использование 
ресурсов) в строки назначений, добавив поле Overtime Work(Сверхурочные 
трудозатраты). При этом необходимо удостовериться в том, чтобы для ресурса была 
определена ставка сверхурочных, чтобы она не была нулевой.  
В случае, когда за ресурс конкурируют две задачи, сверхурочные лучше назначить обеим. 
 

 
 
  

Увеличение доступного времени в календаре ресурса 
 
Альтернативным назначению сверхурочного времени может быть увеличение 
доступного времени в отдельных календарях ресурсов или в основном календаре для 
всех ресурсов проекта. При этом также необходимо помнить о разнице в оплате 
обычного и сверхурочного времени. 
Чтобы увеличить обычное рабочее  время для ресурсов нужно: 
 открыть диалоговое окно Change Working Time (Изменение рабочего времени). Для 

этого используется меню Tools-> Change Working Time 
 в списке For calendar нужно выбрать календарь (основной для проекта или для 

конкретного ресурса), в который будет добавляться рабочее время 
 выделить даты, на которые будет назначено дополнительное время 
 в поля From:   To: ввести дополнительное время. 
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Сокращение  нагрузки на ресурс 
Переназначение части нагрузки ресурса другим ресурсам. 
Сократить нагрузку на ресурс можно, удалив назначение с данного ресурса при помощи 
меню Edit->Delete Assignment (Правка->Удалить назначение).  
Затем можно сделать новое назначение другому ресурсу в окне Assign Resources 
(Назначение ресурсов).   Для того, чтобы определить, какие ресурсы доступны в 
требуемый период времени, можно открыть представление Task Information Form (Форма 
сведение о задачах) и, прокрутив список ресурсов,  просмотреть значение поля Remaining 
Availability (Оставшаяся доступность).  
Сделать замену одного ресурса другим можно также в окне Assign Resources (Назначение 
ресурсов), выделив ресурс, который нужно заменить, и щелкнув по кнопке Replace 
(Заменить). В диалоговом окне Replace Resource (Заменить ресурс) в списке With (На) 
выбрать ресурс, который будет назначен в качестве замены. 
 

Откладывание отдельных назначений и задач 
 
Если превышение доступности ресурса возникло как следствие планирования 
нескольких задач на одно и то же время, необходимо отложить некоторые задачи или 
назначения на более позднее время. 
Отложить назначения можно несколькими способами: 

 посредством поля задачи Delay (Задержка). Задержка начала задачи приведет и 
к откладыванию назначений; 
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 посредством поля Assignmemt Delay (Задержка назначения) для откладывания 
начала назначения отдельного ресурса; 

 
Прерывание отдельных назначений и  задач. 
 
Необходимость прерывания назначений и задач возникает, если в ходе проекта 
происходит наложение задач друг на друга и, как следствие этого наступает 
превышение доступности ресурса. 
Чтобы прервать задачу, можно использовать представление Resource Allocation 
(Выделение ресурсов) инструмент Split Task (Прервать задачу). 
Чтобы прервать задачу в представлении Leveling Gantt Chart (Диаграмма Ганта с 
выравниванием) нужно определить  точную дату и время начала и окончания 
прерывания и щелкнуть по кнопке  Split Task (Прервать задачу). Мышью перенести 
остаток отрезка на дату время возобновления задачи. 
Чтобы прервать назначение нужно использовать представления Resource Usage 
(Использование ресурсов) или Task Usage (Использование задач) и отредактировать 
повременные ячейки со сведениями о назначении.  

 
Выполните лабораторные задания.  
 

Задание 1. Выделите ресурсы с превышением доступности. 
 
Задание 2. Проанализируйте, каким способом лучше устранить превышение доступности 
для каждого перегруженного ресурса. 
 
Задание 3. Попробуйте устранить превышение доступности ресурсов в автоматическом 
режиме. 
 
Задание 4. Устраните превышение  доступности ресурсов вручную, если не получилось 
сделать это автоматически. 

 
Лабораторная работа №8 Анализ и оптимизация плана работ 

 
 
Цель работы – узнать, какие возможности предоставляет программа MS Project для  
анализа плана проекта и оптимизации сроков его выполнения. Будет подробно изучен 
заложенный в программу  стандартный метод PERT(Program, Evaluation and Review 
Technique -Планирование с использованием сетевого графика)  

После того, как  составлен  черновой план проекта, возникает следующий этап 
работы над ним - анализ плана. Обычно в ходе анализа необходимо оценить, насколько 
реалистичны установленные сроки и может ли быть проект выполнен в заданный срок. 
Если при работе над проектом была проведена любая корректировка длительностей задач 
или выравнивание ресурсов, встает тот же самый вопрос. Можно применить экспертный 
метод, однако, лучше и надежнее использовать параметрический метод. Он позволит 
получить более точные оценки,  все необходимые средства для его использования 
заложены в программу. 

В процессе знакомства с формулами мы уже создавали настраиваемые поля, в 
частности для расчета длительности задачи. В программе существует удобная 
возможность  упрощения работы по созданию нового варианта проекта.  
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 Покажем, как можно легко перенести уже созданные настраиваемые 

пользовательские поля из одного файла в другой. Откроем одновременно два файла: 
первый, в котором уже есть нужные нам поля, и второй, в который их надо перенести,  
project1.mpp и project2.mpp.  Затем командой Tools>Organizer(Сервис>Организатор) 
откроем окно Organizer (Организатор) и в открывшемся  окне перейдем на вкладку 
Fields(Поля). Предположим, что созданные нами поля относились к задачам, поэтому 
установим переключатель Task(Задачи), и выберем в выпадающем списке в левой части 
окна файл project1.mpp, а в правой – файл project2.mpp. Теперь, выделив нужные поля, и 
щелкнув по кнопке Copy(Копировать), добавим поля в новый файл project2.mpp. Мы 
хотим уточнить длительность задач, и в качестве параметра для расчетов нам удобно 
использовать общее время редактирования каждой статьи. Название перенесенных нами 
полей возможно были другими, поэтому обычным образом (как и при создании новых 
полей) переименуем поля, назовем их «Число статей» и «Время редактирования статьи». 
В процессе расчетов длительности с введением параметра уже имеющиеся в таблицах 
проекта данные могут быть изменены программой. Следовательно, прежде, чем начать 
расчеты,  удобнее  создать копию таблицы Entry(Ввод данных),  отобразить в ней новые 
поля и всю дальнейшую работу производить с копией. Напомним, что для этого 
достаточно выбрать в меню команду View > Table > more tables (Вид таблица  другие 
таблицы), найти нужную таблицу Entry(Ввод данных) и нажать copy(копировать). Не 
забудьте включить флажок «отобразить в меню». Чтобы исключить задачи, которые никак 
не связаны с обработкой статей, создадим новое поле типа  Flag, назовем его «обработка 
статей». Затем добавим в таблицу столбец с этим полем и установим в нем значение 
«да» для тех задач, длительность которых мы можем рассчитывать по параметрической 
формуле. Потом отфильтруем таблицу по этому полю (для этого следует включить 
автофильтр в строке главного меню и выбрать нужный пункт в выпадающем окне). На 
экране останутся только те задачи, которые содержат в этом поле значение «да». При 
этом, разумеется, эти задачи будут исключены только из вида таблицы, но не из проекта. 
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Результат можно посмотреть в файле project2.mpp. В нем уже введено значение в 
поле «Время редактирования статьи». После того, как длительности по параметрам 
рассчитаны,  нужно обновить данные о трудозатратах в поле Work(Трудозатраты). 

Уточнение длительности по методу PERT 
Для анализа по методу  PERT необходимо вначале вывести в панель инструментов 

соответствующие кнопки. View > Toolbars > PERT Analysis (Вид Панели инструментов 
Анализ по методу PERT).  

  
 
Кроме того, надо перейти в таблицу ввода данных для анализа по методу  PERT. 

Для этого существует специальная кнопка на новой панели. Щелчок по этой кнопке 
откроет таблицу для ввода данных  с вариантами длительности задачи. Рассмотрим работу 
метода на примере с помощью файла project2.mpp. Поле Optimistic 
Dur(Оптимистическая) предназначено для ввода длительности задачи при наиболее 
благоприятном стечении обстоятельств. В поле Expected Dur (Ожидаемая). вводится 
длительность при нормальном развитии событий – чаще всего это значение поля 
Duration(Длительность). Поле Pessimistic Dur (Пессимистическая) содержит 
длительности задач при наихудшем развитии событий. Длительность во всех трех полях 
не обязательно должна быть разной. Для  задач с фиксированной длительностью, 
например, завершающих, или договорных, нужно указывать одинаковые значения во всех 
трех полях. Кроме того, часто ожидаемая длительность совпадает с пессимистической или 
оптимистической оценкой.  
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Анализ по методу PERT можно применять не ко всему проекту, а только для 

некоторых задач. Для этого на панели есть специальная кнопка PERT Entry Form (Форма 
ввода PERT). Вводить данные таким способом можно в любом представлении, установив 
курсор на нужную задачу и вызвав форму.  

 

 
 
После ввода данных можно произвести перерасчет длительности по методу по 

формуле: (оптим. Длительность* оптим. Коэффициент + ожид. Длительность*ожид. 
Коэффициент +  пессим. Длительность* пессим. Коэффициент) / 6.  Очевидно, что 
предварительно надо ввести весовые коэффициенты, которые играют важную роль в 
формуле. Их можно  определить в специальном диалоговом окне Set PERT Weights 
(Задание весовых коэффициентов метода PERT). Сумма весовых коэффициентов 
должна равняться шести, обычно ожидаемая длительность имеет 4, а две остальных по 1. 
Именно такое соотношение задано в программе по умолчанию.  
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После того, как коэффициенты определены, можно перейти к расчету длительности 

задач. Не забудьте, что длительности задач, заданные предварительно, будут изменены. 
Поэтому, желательно, вначале сохранить  копию старого файла под другим именем. 
Чтобы начать анализ надо щелкнуть по кнопке Calculate PERT (Вычисления по методу 
PERT). Перед тем, как произвести  вычисления, программа выведет предупреждение о 
том, что будут изменены значения полей. Изменятся все значения поля 
Duration(Длительность), а также значения первых трех настраиваемых полей 
Start(Начало) и Finish(Окончание). Это происходит из за того, что после проведения 
анализа заново определяются длительности задач, даты их начала и окончания. На 
примере на верхнем рисунке показана диаграмма Ганта до анализа, а на нижнем после 
анализа по методы PERT  
 

 
     

 
 
Рекомендации. С помощью кнопок на панели метода PERT можно посмотреть 

диаграммы Ганта разных версий плана проекта. Для их сравнения удобно открыть 
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одновременно два окна и вызвать в них  соответствующие диаграммы.  Для этого надо 
выбрать в главном меню опцию Windows > Split (Окно >Разделить), потом ввести во 
второе окно нужное представление. Изначально в этом окне будет отображена 
информация только об одной, выделенной задаче. Чтобы увидеть несколько задач, надо их 
выделить все. При анализе оптимистических и пессимистических планов необходимо 
иметь в виду, что крайние сроки и ограничения задач в планах, созданных по методу 
PERT, не учитываются. 

 
Если вы предполагаете, что будете использовать анализ по методу PERT, то стоит 

применить его уже в самом начале составления плана работ.  
 
Оценить, укладывается ли проект в построенный план работ можно с помощью 

индикаторов крайних сроков, уже введенных на предыдущих уроках. Если не 
используется крайний срок, то оценить длительность проекта можно по значению поля  
Duration(Длительность)  в строке суммарной задачи проекта 

 
Напомним, что для ввода крайнего срока надо использовать вкладку Advanced в 

диалоговом окне сведений о задаче. Крайний срок указывается в поле Deadline, 
расположенном над списком выбора типа ограничении.  Если сроки не выполнены, то 
длительность проекта надо уменьшать. Для этого надо сократить длительность тех задач, 
которые не позволяют уложиться в намеченные сроки.  Выбрать задачи, от которых 
зависит длительность проекта можно, если воспользоваться анализом плана проекта 
методом критического пути.  
 

Выполните лабораторные задания. 
Задание 1.  Отфильтруйте в учебном проекте задачи, связанные с обработкой статей,  так, 
чтобы в таблице остались только задачи для анализа длительности исполнения. Создайте 
копию таблицы для дальнейшей работы.  
 
Задание 2. Вызовите PERT Entry Sheet (Лист ввода PERT) и задайте для всех задач 
данные трех вариантов длительностей. Задавайте разные значения. 
 
Задание 3. Задайте весовые коэффициенты и проанализируйте план учебного проекта по 
методу PERT. Сохраняйте измененные таблицы в отдельных копиях для дальнейшего 
сравнения.  
 
Задание 4. Задайте другое соотношение весовых коэффициентов метода и повторите 
анализ. Проследите за изменениями, которые произойдут в проекте.   
 
Задание 5. Проследите за изменениями, которые произойдут в таблицах проекта, если 
сделать пессимистические сроки совпадающими  с ожидаемыми сроками.  
 
Задание 6. Пересмотрите план проекта так, чтобы реальные длительности максимально 
совпадали с ожидаемыми длительностями, полученными в результате анализа. Если 
нужно, обновите крайний срок последней задачи.   
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Лабораторная работа №9 Анализ критических параметров проекта 
 
Критический путь  - это задача (или последовательность задач), определяющая дату 

окончания проекта. Длительность проекта будет увеличиваться или уменьшаться вместе с 
длительностью задачи, лежащей на критическом пути. Программа умеет определять 
время, на которое можно задержать исполнение задачи, это время хранится в поле Total 
Slack(Общий временной резерв). Если эта величина становится неположительной, то 
задача считается критической.  Однако ее можно поменять, например, сделать резерв не 
больше одного дня. После чего задача станет критической. Чтобы определить для проекта 
размер временного резерва надо с помощью команды Tools > Options(Инструменты> 
Опции) открыть диалоговое окно настройки параметров MS Project, перейти на вкладку 
Calculation(Вычисления) и указать нужное значение в поле Tasks are critical is slack is less 
or equal to (Считать критическими задачи, имеющие резерв не более… ) . 

Критическими называются те задачи, которые имеют ограничения типа Must Start 
On (Фиксированное начало), Must Finish On (Фиксированное окончание), As Late As 
Possible (Как можно позже) в проектах, планируемых от даты начала, и As Soon As 
Possible  (Как можно раньше) в проектах, планируемых от даты окончания. Кроме того, 
все задачи, дата окончания которых превышает дату крайнего срока или совпадает с ней. 
Для отображения критического пути проекта надо использовать мастера диаграмм 
Ганта (Gant Chart Wizard), который вызывается командой меню 
Format(Форматирование) или контекстного меню диаграммы Ганта. Выбрав кнопку 
Critical path(Вычислить путь),  следует щелкнуть на Finish(Конец). После этого 
диаграмма Ганта перестроится, критические задачи и связи между ними будут выделены 
красным цветом.  Чтобы сохранить на диаграмме только критические задачи, надо 
воспользоваться фильтром Critical(Критический) 
 

.  
 
«Расчетные требования к ресурсам операции (раздел 6.3.3.1) повлияют на 

длительность плановой операции, так как привлеченные для плановой операции ресурсы и 
их наличие будет в значительной мере влиять на длительность большинства операций. 
Например, если в рамках плановой операции для эффективного выполнения 
проектирования требуется два инженера, а к работе привлечен только один человек, то, 
в принципе, для выполнения плановой операции потребуется как минимум вдвое больше 
времени. Однако по мере привлечения дополнительных ресурсов или при привлечении 
менее квалифицированного персонала для некоторых плановых операций может 
выявиться снижение эффективности проекта. Эта неэффективность, в свою очередь, 
может привести к меньшему увеличению производительности работ относительно 
увеличения объема привлеченных ресурсов.»  
([1], пункт 6.4.1.6, стр. 153.) 

Очевидно для того чтобы задача перестала быть критической можно сократить ее 
длительность. Но при этом если производится сокращение длительности Данной 
конкретной задач, то надо помнить следующее: сокращение длительности критической 
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задачи может не только убрать ее с критического пути, но и сделать критическими другие 
задачи. 

«Сводный календарь ресурсов (раздел 6.3), разрабатываемый в рамках процесса 
оценки ресурсов операций, включает в себя наличие, способности и навыки человеческих 
ресурсов (раздел 9.2). Также учитывается тип, количество, наличие и (если это имеет 
значение) возможности оборудования и материальных средств (раздел 12.4), которые 
могут существенно повлиять на длительность плановых операций. Например, одна и та 
же операция может быть выполнена быстрее или медленнее в зависимости от того, 
кому поручено ее выполнение – опытному исполнителю или новичку.» 
([1], пункт 6.4.1.7, стр.141.) 

Для сокращения длительности задачи можно использовать несколько способов:  
сократить общий объем работы, добавить ресурсы для ускорения выполнения работы, 
сохранив прежний объем. В качестве демонстрации используем файл project2.mpp. После 
выявления критических путей в нашем примере критической оказалась задача 5 
(редактирование третьей статьи). Попробуем добавить дополнительный ресурс для ее 
выполнения, включив в число редакторов лаборанта. В результате задача 5 перестала быть 
критической. Однако возникли две новых критических задачи: номер 3 и номер 11. Для 
того, чтобы устранить этот критический путь увеличим долю участия в проекте главного 
редактора от 20 % до 50. Все задачи перестали быть критическими. Осталось только 
тщательно проследить, не возникло ли перегрузок в ресурсах. В таком случае при оценке 
стоимости проекта необходима будет учитывать трудозатраты на сверхурочную работу.  

 
 
Еще один способ сокращения длительности задачи состоит в том, что по 

возможности задачу разбивают на две подзадачи с одновременным выполнением. Но при 
этом также необходимо следить за возможной перегрузкой ресурсов.  
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Выполните лабораторные задания 

Задание 1. С помощью Gantt Chart Wizard (Мастер диаграмм Ганта) Выделите 
критические пути проекта. Определите задачи, лежащие на критическом пути.   
 
Задание 2. Проанализируйте первый способ устранения критического пути. Выделите 
отдельную критическую задачу и сократите объем работ для ее выполнения.  
 
Задание 3. Проанализируйте второй способ устранения критического пути. Добавьте в 
критическую задачу ресурсы для ускорения выполнения работ, не изменяя их объема.  
 
Задание 4. Проанализируйте третий способ устранения критического пути. Разбейте 
критическую задачу на две подзадачи, выполняемые разными сотрудниками.  
 
Задание  5. Перенесите дату начала проекта на неделю вперед. После этого последняя 
задача проекта станет критической. Измените проект так, чтобы его длительность 
сократилась, и он уложился в срок с помощью добавления в проект новых ресурсов.   

 
Оформление отчета по лабораторной работе 

 
Результаты разработки инновационного проекта при помощи программы Microsoft 

Project студенты оформляют в виде презентации, представленной в Microsoft Office Power 

Point, и защищают на лабораторных занятиях. Авторы наиболее оригинальных разработок 

выступают с докладами на научных конференциях, где в качестве иллюстраций 

используются электронные презентации. 
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